Xerox® Phaser 3320DN/3320DNI System Administrator Guide
# Table of Contents

1 **Introduction**  
Who should use this Guide? ................................................................. 8  
Machine Overview .................................................................................. 9  
Product Configurations ........................................................................... 9  
Control Panel Overview .......................................................................... 10  

2 **Machine Connection**  
Machine Parts and Connection Ports ............................................................ 12  
Front View ............................................................................................. 12  
Rear View .............................................................................................. 13  
Initial Connection ................................................................................... 13  
Administrator Access ................................................................................ 14  
Wireless Connectivity (Phaser 3320DNI) ..................................................... 14  
Configure Ethernet Settings ...................................................................... 15  
Print a Configuration Report .................................................................... 16  
Install the Additional Memory Card (Optional) .......................................... 16  
CentreWare Internet Services .................................................................... 18  

3 **Network Installation**  
TCP/IP .................................................................................................... 24  
Configure Static IPv4 Addressing at the Machine ..................................... 24  
Configure Dynamic IPv4 Addressing at the Machine ............................... 25  
Configure TCP/IP Settings using Internet Services ................................. 26  
Unix ......................................................................................................... 29  
HP-UX Client (Version 10.x) .................................................................... 29  
Solaris 2.x ............................................................................................... 30  
SCO .......................................................................................................... 32  
Linux CUPS ............................................................................................. 33  
Linux LPR via PrintTool .......................................................................... 34  
Linux LPRng ............................................................................................ 35  

4 **Printer Drivers**  
Overview ................................................................................................ 38  
Windows - Installing Driver ..................................................................... 39  
Macintosh - Installing Driver ................................................................. 41  
Linux - Installing Drivers ....................................................................... 43  
Installing the SmartPanel ........................................................................ 43  
Installing the Printer Setting Utility ......................................................... 43
Unix - Installing Drivers .............................................. 45
    Setting up the printer ........................................... 45
    Uninstalling the printer driver package ...................... 46
Sharing your Machine Locally ........................................ 47
    Windows ......................................................... 47
    Macintosh ...................................................... 48
Windows Printing ...................................................... 49
    LPR Printing ................................................... 49
    Internet Printing Protocol (IPP) Port ......................... 52
    Raw TCP/IP Printing (Port 9100) ............................. 54
    USB Printing .................................................. 55
Configure the Windows Printer Driver ............................. 56
    Manual Printer Driver Configuration ......................... 56
Apple Mac .......................................................... 58
    TCP/IP Printing (OSX) ....................................... 58
    Configure your Apple Mac Printer Driver .................... 59
Display Network Settings ........................................... 77
Overview ............................................................ 75
    Information Checklist ........................................ 75
    Enable 802.1X at the machine ............................... 75
Status ............................................................... 81
    Print Information ............................................ 81
Jobs ................................................................. 82
Print ................................................................. 83

5  Security

    Security @ Xerox ................................................ 61
    Security Settings .............................................. 62
        Administrator Accounts ................................... 62
        Feature Management .................................... 62
        Restart Device ........................................... 63
    Machine Digital Certificate Management ..................... 64
    SNMP .......................................................... 69
    SNMPv3 ........................................................ 71
    IP Sec .......................................................... 72
    IP Filtering .................................................... 73
        Overview .................................................... 73
    802.1X Authentication ......................................... 75
        Overview .................................................... 75
        Information Checklist .................................... 75
    Display Network Settings ...................................... 77

6  CentreWare Internet Services

    Overview ......................................................... 80
        Information Checklist .................................... 80
        Enable HTTP at the machine ............................... 80
        Access Internet Services .................................. 80
    Status .......................................................... 81
        Print Information .......................................... 81
    Jobs ............................................................. 82
    Print ........................................................... 83

Xerox Phaser 3320DN/3320DNI
System Administrator Guide
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>84</td>
</tr>
<tr>
<td>Machine Settings</td>
<td>84</td>
</tr>
<tr>
<td>System</td>
<td>84</td>
</tr>
<tr>
<td>Printer</td>
<td>86</td>
</tr>
<tr>
<td>E-mail Notification</td>
<td>88</td>
</tr>
<tr>
<td>Network Settings</td>
<td>89</td>
</tr>
<tr>
<td>Security</td>
<td>92</td>
</tr>
<tr>
<td>Support</td>
<td>95</td>
</tr>
<tr>
<td>Version Information</td>
<td>95</td>
</tr>
<tr>
<td>Firmware Upgrade</td>
<td>95</td>
</tr>
<tr>
<td>To Edit Contact Information Details</td>
<td>95</td>
</tr>
<tr>
<td>Support Links</td>
<td>96</td>
</tr>
<tr>
<td>7 Software Upgrade</td>
<td></td>
</tr>
<tr>
<td>Overview</td>
<td>98</td>
</tr>
<tr>
<td>When should I upgrade the software?</td>
<td>98</td>
</tr>
<tr>
<td>8 Troubleshooting</td>
<td></td>
</tr>
<tr>
<td>Problem Solving Procedure</td>
<td>102</td>
</tr>
<tr>
<td>Printing</td>
<td>103</td>
</tr>
<tr>
<td>Connectivity</td>
<td>104</td>
</tr>
<tr>
<td>9 Appendix A</td>
<td></td>
</tr>
<tr>
<td>Management Information Base (MIB)</td>
<td>107</td>
</tr>
</tbody>
</table>
Introduction

Welcome to the Xerox Phaser 3320DN/3320DNI System Administrator Guide. This chapter includes:

- Who should use this Guide? on page 8
- Machine Overview on page 9
- Control Panel Overview on page 10
Who should use this Guide?

This guide is intended for System Administrators who need to install, setup and manage printers on their network.

To use the procedures in this guide effectively, System Administrators must have previous experience working in a network environment and must possess Supervisor, Administrator, Account Operator, or equivalent rights to the network. They must also have prior knowledge of how to create and manage network user accounts.
Machine Overview

The Xerox Phaser 3320DN/3320DNI are environmentally friendly printing machines providing excellent quality and speed. The features and functions available on your machine depend on the model you have purchased.

Product Configurations

<table>
<thead>
<tr>
<th>Component</th>
<th>Phaser 3320DNI</th>
<th>Phaser 3320DN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Tray 1 (250 sheets)</td>
<td>Standard</td>
<td>Standard</td>
</tr>
<tr>
<td>Bypass Tray (50 sheets)</td>
<td>Standard</td>
<td>Standard</td>
</tr>
<tr>
<td>Paper Tray 2 (520 sheets)</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>Network Printing</td>
<td>Standard</td>
<td>Standard</td>
</tr>
<tr>
<td>USB Port</td>
<td>Standard</td>
<td>Standard</td>
</tr>
<tr>
<td>128MB Memory</td>
<td>Standard</td>
<td>Standard</td>
</tr>
<tr>
<td>256MB Additional Memory Expansion</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>Wireless Enabled</td>
<td>Standard</td>
<td>Not Applicable</td>
</tr>
</tbody>
</table>
## Control Panel Overview

<table>
<thead>
<tr>
<th></th>
<th><strong>Display Screen:</strong> Displays the current machine status and prompts during an operation.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td><strong>Arrows:</strong> The up/down and left/right arrows are used to scroll through the options available in the selected menu, and to increase or decrease values.</td>
</tr>
<tr>
<td>3</td>
<td><strong>OK:</strong> Confirms the selection on the screen.</td>
</tr>
<tr>
<td>4</td>
<td><strong>Menu:</strong> Enters Menu Mode and enables you to access options and settings.</td>
</tr>
<tr>
<td>5</td>
<td><strong>Back:</strong> Used to go back one level in the menu.</td>
</tr>
<tr>
<td>6</td>
<td><strong>Power Save:</strong> Sends the machine into Power Save mode or Power Down. Press the button again to restart the machine.</td>
</tr>
<tr>
<td>7</td>
<td><strong>Stop:</strong> Pressing the Stop button stops an operation at any time.</td>
</tr>
</tbody>
</table>
| 8 | **Status / Wireless LED:** The color of the LEDs indicates the machine’s current status. For more information refer to the User Guide supplied with your machine.  
**Note:** The Wireless LED applies to the Phaser 3320DNI only. |
Machine Connection

This chapter shows you how to connect your machine to a network and configure the Ethernet settings and includes:

- Machine Parts and Connection Ports on page 12
- CentreWare Internet Services on page 18
Machine Parts and Connection Ports

Front View

<table>
<thead>
<tr>
<th></th>
<th>Machine Part</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Output Tray</td>
<td>7</td>
<td>Paper Tray 1</td>
</tr>
<tr>
<td>2</td>
<td>Control Panel</td>
<td>8</td>
<td>Bypass Tray</td>
</tr>
<tr>
<td>3</td>
<td>Control Board Cover</td>
<td>9</td>
<td>Bypass Tray Extension</td>
</tr>
<tr>
<td>4</td>
<td>Front Cover</td>
<td>10</td>
<td>Bypass Tray Width Guides</td>
</tr>
<tr>
<td>5</td>
<td>Paper Level Indicator</td>
<td>11</td>
<td>Output Tray Support</td>
</tr>
<tr>
<td>6</td>
<td>Paper Tray 2 (Optional)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Machine Parts and Connection Ports
Rear View

Initial Connection

The On/Off switch, the power outlet and the Network Port are at the rear of the machine. Follow these steps to physically connect your machine to the network:

1. Connect the Power Cord to the machine and a suitable power supply outlet. The power cord must be plugged into a grounded power socket.
2. Connect the Network Cable if required. The Phaser 3320DNI will also connect to a wireless network, if available, when powered on.

   **Note:** If you choose a wireless connection for your Phaser 3320DNI printer, you cannot use a wired connection at the same time.
Installation Wizard

On initial power On the Installation Wizard runs:

1. The Language menu displays. Press the arrow buttons to highlight the required language and press OK.
2. The Metric Default menu displays. Press the arrow buttons to select one of the following and press OK:
   - Inches
   - mm
3. The Default Paper menu displays. Press the arrow buttons to select one of the following and press OK:
   - Letter
   - A4
4. The Support Info menu displays.
   a. Press the arrow buttons to select Cust. Support and press OK. Use the arrow buttons to enter the customer support telephone number and press OK.
   b. Press the arrow buttons to select Supplies Order and press OK. Use the arrow buttons to enter the supplies ordering telephone number and press OK.
5. The Installation Complete screen displays. Press OK.

Administrator Access

The machine feature and setup options are accessed through the Menu button on the control panel. The setup options should be set up and customized by the System Administrator. Access to these options is sometimes password protected.

Entering a password:

6. Press the Menu button on the control panel.
7. Press the down arrow button to scroll to Network Setup and press OK. The Enter Password screen displays.
8. Enter the machine password, the default is 1111:
   - Press the up arrow button to get number 1 on the screen.
   - Press the right arrow button to get the second number in the password.
   - Continue pressing the up arrow to select the required number and the right arrow to move across until you have entered the whole password.
9. Select OK.

Wireless Connectivity (Phaser 3320DNI)

The Phaser 3320DNI is compatible with 802.11 (Wi-Fi®) wireless networks, when used with an external wireless adapter 802.11 Ethernet Bridge. The location where the machine is installed must be covered by an 802.11 wireless network. This is typically provided by a nearby wireless access point or router, which is physically connected to the wired Ethernet that serves the building.
The machine supports connectivity via a wireless only connection if required.

Note: If a wireless network is available, the Phaser 3320DNI will automatically configure wireless networking when powered on.

There are several ways to configure Wireless Connectivity:

- At the Machine. For instructions refer to *Configure Wireless Connectivity at the Machine (Phaser 3320DNI)* on page 15.
- Using *Internet Services*. For instructions refer to *Configure Wireless Connectivity Using Internet Services (Phaser 3320DNI)* on page 19.
- With the *Wireless Setting Program*. For instructions refer to *Wireless Setup (Phaser 3320DNI)* on page 40.

**Configure Wireless Connectivity at the Machine (Phaser 3320DNI)**

1. Press the *Menu* button on the control panel.
2. Press the arrow buttons to select *Network Setup* and press *OK*.
3. Enter the *Administrator Password* using the arrow buttons. The default is *1111*. Refer to *Entering a password* on page 14.
4. Press the arrow buttons to select *Wireless* and press *OK*. The options are:
   - *Wi-Fi ON/OFF* - allows you to enable or disable wireless connectivity.
   - *WPS Settings* - allows you to select the Wi-Fi Protected Setup - the options are *PBC* or *PIN*.
   - *WLAN Default* - allows you to restore the default wireless settings.
   - *WLAN Signal* - allows you to view the strength of the wireless connection.
5. At the *Wireless* menu, press the arrow buttons to select *Wi-Fi ON/OFF* and press *OK*. Ensure that *On* is selected and press *OK*.
6. Press the arrow buttons to select *WPS Settings* and press *OK*.
7. Select *Yes* to apply the changes.

**Configure Ethernet Settings**

The Ethernet interface will automatically detect the speed of your network. The machine supports hub/switch speeds of:

- Auto
- 10M Full
- 100M Full
- 10M Half
- 100M Half
- 1 Giga Full

Set the Ethernet speed on the machine to match the speed set on your hub or switch:

**Setting the Ethernet Speed at the Machine**

1. Press the *Menu* button.
2. Press the arrow buttons to highlight **Network Setup** and press **OK**.

3. Enter the **Administrator Password** using the arrow buttons. The default is **1111**. Refer to Entering a password: on page 14.

4. Use the arrow buttons to scroll to **Ethernet Speed** and press **OK**.

5. Use the arrow buttons to select one of the following speeds:
   - Automatic
   - 10 Mbps Half
   - 10 Mbps Full
   - 100 Mbps Half
   - 100 Mbps Full
   - 1 Gbps Full

6. Press **OK**. The **Please Reboot** message displays.  
   
To reboot the machine, press the **power switch** off, wait two seconds and press the power switch back on.

To set the Ethernet Speed using Internet Services, refer to Setting the Ethernet Speed Using Internet Services on page 20.

---

**Print a Configuration Report**

The **Configuration Report** details the machine software versions and network settings configured for the machine.

**Print a Configuration Report at the Machine**

1. Press the **Menu** button.

2. Press the arrow buttons to scroll to **Information** and press **OK**.

3. Press the arrow buttons to select **Configuration** and press **OK**.

Use the arrow buttons to select **Yes** and press **OK**. The **configuration report** will print.

You can also print the **Configuration Report** using **Internet Services**. Refer to **Status** on page 81.

**Install the Additional Memory Card (Optional)**

The machine supports memory expansion through the installation of an additional memory card. Memory expansion is an option for the machine.

The machine has a dual in-line memory module (DIMM). Use this memory module slot to install additional memory.

1. Turn the machine off and unplug all cables from the machine.

2. Grasp the control board cover and remove it.

3. Remove the new memory module from its bag.
4. Holding the memory module by the edges, align the memory module on the slot at about a 30-degree tilt. Make sure that the notches of the module and the grooves on the slot fit each other.  
   **Note** The notches and grooves illustrated may not match those on an actual memory module and its slot.

5. Press the memory module into the slot with care until you hear a ‘click’.
6. Do not press the memory module strongly or the module may be damaged. If the module does not seem to fit into the slot properly, carefully try the previous procedure again.
7. Replace the control board cover.
8. Reconnect the power cord and machine cable and turn the machine on.
CentreWare Internet Services

CentreWare Internet Services (Internet Services) is the embedded HTTP server application that resides in the machine. Internet Services allows an administrator to change network and system settings on the machine from the convenience of their workstation.

Many features available on your machine will need to be set via the machine and CentreWare Internet Services.

System Configuration

To use CentreWare Internet Services, you need to enable both TCP/IP and HTTP on the machine. See Configure Static IPv4 Addressing at the Machine on page 24, or Configure Dynamic IPv4 Addressing at the Machine on page 25.

To enable HTTP at the machine:

Note HTTP is enabled by default.

1. Press the Menu button.
2. Use the up/down arrows to select Network Setup.
3. Enter the Administrator password. The default is 1111. Refer to Entering a password: on page 14.
4. Use the arrow buttons to select HTTP Activate.
5. Use the arrow buttons to select On.
6. Press OK.
7. Press the power switch off, wait two seconds and press the power switch back on.

Administrator User Name and Password

Many of the features available within CentreWare Internet Services will require an Administrator user name and password. The default user name is admin and the default password is 1111.

Internet Services Administrator Access

To access Internet Services Properties and change settings you will need to login as Administrator.

1. At your workstation, open the web browser and enter the IP Address of the machine in the Address Bar.
2. Press Enter. The Home page appears.
   There are two ways to access Internet Services with the administrator login:
   - Select Login at the top of the screen
   - Select the Properties icon
3. Enter the Administrator User Name (admin) and Password (1111) and select Login.
4. Click Properties.
**Change the Administrator Password**

It is recommended that you change the default administrator password to a more secure password, so this Xerox machine is not compromised.

**To change the Administrator password:**

1. At your workstation, open the web browser and enter the *IP Address* of the machine in the Address Bar.
2. Press **Enter**.
3. Select the **Properties** icon.
4. If prompted, enter the Administrator *User Name* (*admin*) and *Password* (*1111*), and select **Login**.
5. Click **Properties**.
6. In the **Security** link on the left hand side, select **System Security**.
7. Select the **System Administrator** link.
8. In the **Access Control** area:
   a. Ensure **Web UI Access Control** checkbox is selected.
   b. In the **Login ID** field, enter a new login name.
   c. Select the **Change password** box to change the password. In the **Password** field, enter a new numeric password.
   d. Enter the password again in the **Confirm Password** field.

**CAUTION:** Do not forget the password or you could be completely locked out of the system, requiring a service call.

9. Select **Apply** to save the changes.
10. Select **OK** when the acknowledgement message displays.
11. Select the **Advanced** button. The **Advanced Access Control** screen appears.
12. Select **Protect Login IPv4 Address** checkbox to enable this feature if required, and enter an **IPv4 Address** in the box.
13. Select the required option for the **Login Failure Policy**, for users who fail to login several times. The options are: **Off**, **3 times** or **5 times**.
14. Select the required option for **Auto Logout**. The options are **5, 10, 15** or **30 minutes**.
15. Enable **Security Settings Reset** if required.
16. Select **Save** to save your changes.

For further information, refer to **Administrator Accounts** on page 62.

**Configure Wireless Connectivity Using Internet Services (Phaser 3320DNI)**

1. At your workstation, open the web browser and enter the *IP Address* of the machine in the Address Bar.
2. Press **Enter**.
3. Select **Properties**.
4. If prompted, enter the Administrator *User Name* (*admin*) and *Password* (*1111*), and select **Login**.
5. Click Properties.
6. In the Network Settings link, select the Wireless link.
7. The Connection Status shows the Link Status of the wireless connection.
8. The Wireless Settings area provides options to configure wireless connectivity. The options are Easy Wireless Settings and Advanced Settings, and are explained below.

Use the Easy Wireless Settings Wizard

1. Select the Easy Wireless Settings Wizard button to have the machine find the WPS Settings automatically. The SSID screen appears with a list of available wireless networks.
2. Select the required Network Name SSID and click Next.
3. If encryption is required,
   a. Enter the WPA Shared Key.
   b. Enter the Confirm Network Key and click Next.
4. The Wireless Setup Confirmation screen appears. Click Apply.

Configure Advanced Wireless Settings

1. Select the Advanced Settings Custom button. The Advanced Wireless Setup screen appears.
2. To enable Wireless Radio, select On from the Wireless Radio menu.
3. Select the required option for SSID:
   - Select Search List and select the required network from the drop-down menu. Click the Refresh button to update the list of networks available.
   - Select Insert New SSID to enter a wireless network name.
4. Select the required Operation Mode:
   - Select Ad Hoc to communicate on the wireless network without a wireless access point. Select the required channel from the Ad-Hoc Channel menu.
   - Select Infrastructure to connect to a wireless access point.
5. In the Security Setup area:
   a. Select the required method of Authentication.
   b. Select the required method of Encryption.
6. Depending on your selections you may be required to enter some or all of the following information for the Network Key Setup.
   a. Select the required option for Using Key.
   b. The Hexadecimal option may be enabled. Click the Hexadecimal checkbox to deselect if required.
   c. Enter the required Network Key and Confirm Network Key.
7. Select Apply to save the changes.

Setting the Ethernet Speed Using Internet Services

1. At your workstation, open the web browser and enter the IP Address of the machine in the Address Bar.
2. Press Enter.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. Click Properties.
5. In the Network Settings link select the General link.
6. Select one of the following speeds from the Ethernet Speed drop-down menu:
   - Automatic
   - 10 Mbps (Half Duplex)
   - 10 Mbps (Full Duplex)
   - 100 Mbps (Half Duplex)
   - 100 Mbps (Full Duplex)
   - 1 Gbps (Full Duplex)
7. Select on Apply to save the changes.
   The change to the Ethernet Speed rate will take effect after the System Reboot screen appears.
8. When the Acknowledgement screen displays, select OK.
9. Reboot the machine.
Network Installation

This chapter covers the following topics:

- TCP/IP on page 24
- Unix on page 29
TCP/IP

These instructions show you how to configure the following:

- TCP/IP v4 and v6
- Domain Name
- DNS
- Zero Configuration Networking

The machine supports TCP/IP versions 4 and 6. IPv6 can be used instead of or in addition to IPv4.

IPv4 and IPv6 settings can be configured directly at the machine, or remotely, via a web browser using Internet Services. To configure TCP/IP settings using Internet Services, refer to Configure TCP/IP Settings using Internet Services on page 26.

Configure Static IPv4 Addressing at the Machine

Information Checklist

Before starting please ensure that the following items are available and/or the tasks have been performed:

- Existing operational network utilizing the TCP/IP protocol.
- Ensure that the machine is connected to the network.
- Static IP Address for the machine.
- Subnet Mask Address for the machine.
- Gateway Address for the machine.
- Host Name for the machine.

Procedure

Enter a Static IP Address:

1. Press the Menu button on the control panel.
2. Press the arrow buttons to scroll to Network Setup; press OK.
3. Enter the Administrator Password using the arrow buttons. The default is 1111. Refer to Entering a password: on page 14.
4. Press the OK button.
5. Press the arrow buttons to select TCP/IP (IPv4); press OK.
6. Press the arrow buttons to select Static; press OK.
7. Press the arrow buttons to select IP Address; press OK.
8. Enter the IP Address using the arrow buttons and press OK.
9. Enter details for Subnet Mask using the arrow buttons; press OK.
10. Enter details for Gateway using the arrow buttons; press OK.
11. The Saved screen will display and return to the TCP/IP (IPv4) menu.
DNS Configuration:
12. From the TCP/IP (IPv4) menu, press the arrow buttons to select Static; press OK.
13. Press the arrow buttons to highlight Primary DNS; press OK.
14. Enter details for Primary DNS using the arrow buttons and press OK. The Saved screen will display and return to the Static menu.
15. Press the arrow buttons to highlight Secondary DNS; press OK.
16. Enter details for Secondary DNS using the arrow buttons and press OK. The Saved screen will display and return to the Static menu.

Configure Dynamic IPv4 Addressing at the Machine

Information Checklist

Before starting please ensure that the following items are available and/or the tasks have been performed:
- Existing operational network utilizing the TCP/IP protocol.
- DHCP or BOOTP Server should be available on the network.
- Ensure that the machine is connected to the network.

Procedure

Installation via DHCP (Dynamic Host Configuration Protocol)

DHCP is enabled on the machine by default. If the machine is connected to the network, the TCP/IP information will be configured when the machine is powered on and no further configuration is required.
1. Print a Configuration Report to verify that the information was assigned correctly. Refer to Print a Configuration Report on page 16.

Installation via BOOTP or DHCP

Ensure your machine is connected to the network with Ethernet cabling.
1. Press the Menu button on the control panel.
2. Use the arrow buttons to scroll to Network Setup; press OK.
3. Enter the Administrator Password using the arrow buttons. The default is 1111. Refer to Entering a password: on page 14.
4. Press the OK button.
5. Press the arrow buttons to scroll to TCP/IP (IPv4); press OK.
6. Press the arrow buttons to select DHCP; press OK.
7. The Saved screen will display and return to the Network Setup menu.
Configure TCP/IP Settings using Internet Services

IPv4
1. At your workstation, open the web browser and enter the IP Address of the machine in the Address Bar.
2. Press Enter.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login.
5. Click Properties.
6. In the Network Settings link select TCP/IPv4 from the directory tree. The TCP/IPv4 page displays.
7. In the Assign IPv4 Address menu, select Automatically or Manually.
8. If Manually is selected, in the TCP/IP Settings area enter details of the machine in the following fields:
   a. IPv4 Address
   b. Subnet Mask
   c. Gateway Address
   If Automatically is selected, select BOOTP or DHCP.

Notes:
- If BOOTP or DHCP mode is selected, you cannot change the IP Address, Network Mask, or Router/Gateway Address. Select Auto IP if required.
- New settings will not be applied until the machine is rebooted. Changing the machine’s TCP/IP setting may cause you to lose your connection to the machine.
9. In the Domain Name area:
   a. Enter a domain name in the Domain Name field.
   b. Enter an IP address in the Primary DNS Server and Secondary DNS Server fields.
   c. Select the Enabled box to enable Dynamic DNS Registration if required.
   Note: If your DNS Server does not support dynamic updates there is no need to select Enabled.
10. In the WINS area select the box to enable WINS and enter details in the following fields:
   a. Primary WINS Server
   b. Secondary WINS Server
11. Select Apply to save the changes.
12. Select OK when the acknowledgement message displays.

IPv6
1. At your workstation, open the web browser and enter the IP Address of the machine in the Address Bar.
2. Press Enter.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login.
5. Click Properties.
6. In the **Network Settings** link select **TCP/IPv6** from the directory tree.
7. Select the **Enabled** checkbox to enable IPv6 protocol.
8. To set a manual address, select **Enable Manual Address** and enter the address and prefix in the **Address/Prefix** area. Information in the **Assigned IPv6 Addresses** box is automatically populated.
9. The machine performs auto-address DHCPv6 configuration every time it powers up. This is used for neighbor discovery and address resolution on the local IPv6 subnet. However, you can choose to use manual configuration, automatic configuration or a combination of automatic and manual configuration.

In the **Default Dynamic Host Configuration Protocol Version 6 (DHCPv6)** area, select one of the following options:

- **Use DHCP as directed by a router** - this option is fully automatic. The DHCPv6 Address will be obtained and displayed on the screen.
- **Always Enable DHCP** - this option is fully automatic. The DHCPv6 Address will be obtained and displayed on the screen.
- **Never use DHCP** - when this option is selected, you must configure the Manual Address Options and DNS separately.

10. In the **Domain Name System Version 6 (DNSv6)** area:
   a. Enter valid details in the **IPv6 Domain Name** field.
   b. Enter an IP addresses for the **Primary DNSv6 Server Address** and **Secondary DNSv6 Server Address**.
   c. Check the **Dynamic DNSv6 Registration** checkbox to enable this option.

   **Note:** If your DNS Server does not support dynamic updates there is no need to enable DDNS.

11. Select **Apply** to save the changes.
12. Select **OK** when the acknowledgement message displays.

   **Note:** Enabling or disabling the TCP/IPv6 protocol will take effect after the system is rebooted. Enabling or disabling TCP/IPv6 will impact other protocols, for example LPR/LPD, SNMP, Raw TCP/IP Printing and DHCPv6 over TCP/IPv6.

**Test Access**

1. At your workstation, open the Web browser and enter the TCP/IP Address of the machine in the Address bar. Press **Enter**.

   If you use the domain name to specify the machine, use the following format.

   `http://myhost.example.com`

   If you use the IP address to specify the machine, use one of the following formats depending on your machine configuration. An IPv6 address needs to be enclosed in square brackets.

   **IPv4:** `http://xxx.xxx.xxx.xxx`

   **Note:** If you have changed the port number from the default port number “80”, append the number to the Internet address as follows. In the following examples, the port number is 8080.

   **Domain name:** `http://myhost.example.com:8080`
   **IPv4:** `http://xxx.xxx.xxx.xxx:8080`
TCP/IP


2. Verify that the home page of Internet Services is displayed.

The Internet Services installation process is now completed.

Note: When your access to Internet Services is encrypted, enter “https://” followed by the Internet address, instead of “http://”.
HP-UX Client (Version 10.x)

HP-UX workstations require specific installation steps to communicate with the machine. The machine is a BSD-style UNIX printer, whereas HP-UX is a System V-style UNIX.

IMPORTANT: All UNIX commands are case sensitive, so enter the commands exactly as they are written.

Information Checklist

Before starting please ensure that the following items are available and/or the tasks have been performed:

- Existing operational network utilizing the TCP/IP protocol.
- Ensure that the machine is connected to the network.
- Static IP Address for the machine.
- Subnet Mask Address for the machine.
- Gateway Address for the machine.
- Host Name for the machine.

Procedure

1. Follow the steps in Configure Static IPv4 Addressing at the Machine on page 24, then return to this page.

Configure the Client

1. Add the machine Host Name to the etc/hosts file on the HP-UX workstation.
2. Ensure that you can ping the machine from the HP-UX workstation.
3. Use either the GUI method or the tty methods as detailed below:

GUI Method

1. Open a Command window from the desktop.
2. Enter su to access Super User mode.
3. Enter sam to start the System Administrator Manager (SAM).
4. Select the Printers and Plotters icon.
5. Select lp spooler.
7. Select Actions: Add Remote Printer/Plotter....
8. Enter the following information into the Add Remote Printer/Plotter form:
   a. Printer Name: printer name.
      Where printer name is the name of the queue being created.
b. Remote System Name: **hostname**.
   Where **hostname** is the machine hostname from the `/etc/hosts` file.

c. Select **Remote Printer is on a BSD System**.

d. Select **OK** to complete the form.

9. Select **Yes** at the **Configure HP UX Printers Subpanel** screen. This screen may be obscured by the **Add Remote Printer/Plotter** form.

10. Select **File: Exit**.

11. Select **File: Exit Sam**.

12. Enter **Exit** to exit **Super User** mode.

13. Test the queue created, by entering the command:

   ```
   lp -d queue name /etc/hosts.
   ```

14. Verify that the job prints at the machine.

**tty Method**

1. Enter **su** to access **Super User** mode.

2. Enter **sh** to run the **Bourne shell**.

3. Enter **lpshut** to stop the print service.

4. Create the print queue by typing (on the same command line):

   ```
   lpadmin -p queue name > -v / dev/ null -m rmodel -o cmrcmodel -osmrsmmodel -ob 3 -orc -ormhostname -orlp
   ```

   Where **queue name** is the name of the queue being created and **hostname** is the machine hostname.

5. Enter **lpsched** to start the print service.

6. Enter **enable queue name** to enable the queue to print to the machine.

7. Enter **accept queue name** to the queue accepting jobs from the HP-UX workstation.

8. Enter **Exit** to exit the **Bourne shell**.

9. Enter **Exit** to exit **Super User** mode.

10. Test the queue created, by entering the command:

    ```
    lp -d queue name /etc/hosts.
    ```

11. Verify that the job prints at the machine.

**Solaris 2.x**

**Information Checklist**

Before starting please ensure that the following items are available and/or the tasks have been performed:

- Existing operational network utilizing the TCP/IP protocol.
- Ensure that the machine is connected to the network.
- Static IP Address for the machine.
- Subnet Mask Address for the machine.
• Gateway Address for the machine.
• Host Name for the machine.

Procedure

Follow the steps in Configure Static IPv4 Addressing at the Machine on page 24 then return to this page.

Configure the Client
1. Add the machine printer Host Name to the etc/hosts file.
2. Ensure that you can ping the machine.
3. Use either the GUI method or the tty method as detailed below:

GUI Method
1. Open a Command window from the desktop.
2. Enter su to access Super User mode.
3. Enter admintool to run the System Administrator Tool.
5. Select Edit:Add:Access to Printer....
6. Enter the following information into the Access to Remote Printer form:
   a. Printer Name: queueame.
      Where queueame is the name of the queue being created.
   b. Print Server: hostname.
      Where hostname is the machine hostname from the /etc/hosts file.
   c. Select OK to complete the form.
7. Enter sh to run the Bourne shell.
8. Enter the command: ladmin -p queueame -s hostname !lp to modify the remote queueame.
9. Enter Exit to exit the Bourne shell.
10. Enter Exit to exit Super User mode.
11. Test the queue created, by entering the command:
    lp -d queueame /etc/hosts.
12. Verify that the job prints at the machine.

tty Method
1. Enter su to access Super User mode.
2. Enter sh to run the Bourne shell.
3. Define the machine as a BSD style printer, by entering the command:
   lpsystem -t bsd hostname
   Where hostname is the machine hostname from the /etc/hosts file.
4. Create the queue, by entering the command:
   ladmin -p queueame -s hostname -T unknown -I any
   where queueame is the name of the queue being created.
5. Enter Exit to exit the Bourne shell.
6. Enter **Exit** to exit **Super User** mode.
7. Test the queue created, by entering the command:
   
   ```
   lp -d queue name /etc/hosts.
   ```

8. Verify that the job prints at the machine.

**SCO**

SCO UNIX workstations require specific installation steps to communicate with the machine. The machines are BSD-style UNIX printers, whereas SCO is a System V-style UNIX.

**Information Checklist**

Before starting please ensure that the following items are available and/or the tasks have been performed:

- Existing operational network utilizing the TCP/IP protocol.
- Ensure that the machine is connected to the network.
- Static IP Address for the machine.
- Subnet Mask Address for the machine.
- Gateway Address for the machine.
- Host Name for the machine.

**Procedure**

Follow the steps in **Configure Static IPv4 Addressing at the Machine** on page 24, then return to this page.

**Configure the Client**

1. Add the machine printer **Host name** to the **etc/hosts** file on the SCO workstation.
2. Ensure that you can ping the machine from the SCO workstation.
   Perform the following steps to create a machine print queue on a SCO UNIX workstation using either the GUI or the TTY method.

**GUI Method**

1. Log in as root.
2. From the main desktop, select the icons **System Administration: Printers: Printer Manager**.
3. Select **Printer: Add Remote: UNIX...**
4. Enter the following information into the **Add Remote UNIX Printer** form:
   a. **Host**: `hostname`.
      Where `hostname` is the machine Host Name from the `/etc/hosts` file.
   b. **Printer**: `name of the queue being created`.
      For example: `dc xxxq`.
   c. Select **OK** to complete the form.
5. Select **OK** in the **Message** window.
6. Select **Host: Exit**.
7. Select File: Close this directory.
8. Select File: Close this directory.
9. Select Save in the Warning Confirmation window.
10. Enter Exit to log out of root account.
11. Open Unix Window.

**tty Method**
1. Enter su to access Super User mode.
2. Enter rlpconf to create a printer.
3. Enter the following information:
   a. Printer Name: queue name
   b. Remote Printer: r
   c. Hostname: hostname
   d. If the information has been entered correctly, enter y
4. Select Enter to accept the default for a non-SCO remote printer.
5. Select Enter to accept the default for non-default printer.
6. Select Enter to start the process for adding a queue.
7. Enter q to quit the rlconf program.

**Linux CUPS**

**Static Addressing**

**Information Checklist**

Before starting please ensure that the following item is available and/or the task has been performed:
- Linux operating system that supports printtool.

**Procedure**

Follow the steps in Configure Static IPv4 Addressing at the Machine on page 24, then return to this page.

**Create the Print Queue**

1. Ensure that the Common UNIX Printing System (CUPS) is installed and started on your client.
   The latest version of CUPS is available at cups.org.
2. Open the web browser from your workstation.
3. For example, enter http://127.0.0.1:631/printers in the Address Bar.
4. Press Enter.
5. Select Add Printer.
7. Enter the root and the root password.
8. In the **Add New Printer** screen enter a name for the printer.
9. Enter a location and description for the printer (optional).
10. Select **Continue**.
11. In the **Machine** menu, select **Internet Printing Protocol**.
12. Select **Continue**.
   Where `hostname` is the hostname of the Xerox machine and `printername` is the printer name of
   the Xerox machine.
14. Select **Continue**.
15. Select **Xerox** in the **Make** menu.
16. Select **Continue**.
17. Select the correct driver in the **Driver** menu.
18. Select **Continue**.
19. The **Printer Added Successfully** message will appear.

**Dynamic Addressing**

**Procedure**

Follow the steps in **Configure Dynamic IPv4 Addressing at the Machine** on page 25, then return to this page.

**IMPORTANT:** Highlight **BOOTP** in step 6.

**Create the Print Queue**

Follow the steps to **Create the Print Queue** on page 33.

**Linux LPR via PrintTool**

**Static Addressing**

**Information Checklist**

Before starting please ensure that the following item is available and/or the task has been performed:
- Linux operating system that supports PrintTool.

**Procedure**

1. Follow the steps in **Configure Static IPv4 Addressing at the Machine** on page 24, then return to this page.

**Create the Print Queue**

2. Log in, at the Linux Client, as **root** in a terminal.
3. Enter **printtool**.
4. The Red Hat Linux Print System Manager will launch.
5. Select Add.
6. The Add a Printer Entry window will appear.
7. Select Remote Unix (lpd) Queue.
8. Select OK.
10. Enter the name of your Print Queue in the Names area.
11. The Spool directory is the directory where print jobs are stored and is a subdirectory of /var/spool/lpd. Add the name of the print queue to the end of the subdirectory path.
12. Ensure that the File Limit reads 0.
13. In the Remote Host area, enter the IP Address of the Xerox machine.
14. In the Remote Queue area, enter the Print Queue Name from step 9.
15. DO NOT select the Input Filter option.
16. Leave the default Suppress Headers selected.
17. Select OK.
18. The printer should now be listed in the Red Hat Linux Print System Manager window. Select the lpd menu.
19. Select Restart lpd.
20. Select the PrintTool menu.
21. Select Exit to close the program.
22. To allow access to the printer, edit the /etc/hosts table to list the client system.
23. Edit and create the /etc/hosts.lpd file to list the client system.

**Dynamic Addressing**

**Procedure**

Follow the steps in Configure Dynamic IPv4 Addressing at the Machine on page 25, then return to this page.

**IMPORTANT:** Highlight BOOTP in step 6.

**Create the Print Queue**

Follow the steps to Create the Print Queue on page 33.

**Linux LPRng**

**Static Addressing**

**Information Checklist**

Before starting please ensure that the following item is available and/or the task has been performed:
• Linux operating system that supports PrintTool.

Procedure

Follow the steps in Configure Static IPv4 Addressing at the Machine on page 24, then return to this page.

Create the Print Queue
1. Open the LPRngTool from the Linux Client.
2. Select Add.
3. In the Names area, enter a name for your print queue.
4. The spool directory is the directory where print jobs are stored and is a subdirectory of /var/spool/lpd. Add the name of the print queue to the end of the subdirectory path.
5. In the Hostname/IP of Printer area, enter the hostname or IP Address of the Xerox machine.
6. Select OK.
7. Select Exit to close the program.
8. To allow access to the printer, edit the /etc/hosts table to list the client system.
9. Edit and create the /etc/hosts.lpd file to list the client system.

Dynamic Addressing

Procedure

Follow the steps in Configure Dynamic IPv4 Addressing at the Machine on page 25, then return to this page.

IMPORTANT: Highlight BOOTP in step 6.
• Follow the steps to Create the Print Queue on page 33.
Printer Drivers

This chapter explains how to install the printer drivers on your computer and covers the following topics:

- Overview on page 38
- Windows - Installing Driver on page 39
- Macintosh - Installing Driver on page 41
- Linux - Installing Drivers on page 43
- Unix - Installing Drivers on page 45
- Sharing your Machine Locally on page 47
- Windows Printing on page 49
- Configure the Windows Printer Driver on page 56
- Apple Mac on page 58
Overview

The *Software and Documentation CD* is supplied with your machine. The machine supports the following operating systems:

- **Windows**
  - Windows 2000
  - Windows XP
  - Windows Server 2003
  - Windows Vista
  - Windows Server 2008
  - Windows 7
  - Windows 2008 Server R2

- **Macintosh**
  - Mac OS X 10.3 ~ 10.4
  - Mac OS X 10.5
  - Mac OS X 10.6
  - Mac OS X 10.7

- **Linux**
- **Unix**
Windows - Installing Driver

You can install the printer software using the *typical* or the *custom* method.

The steps below are recommended for most users who use a machine that is directly connected to a workstation. All components necessary for machine operation will be installed.

**Information Checklist**

Before starting, please ensure that the following items are available and/or the tasks have been performed:

- Make sure that the machine is connected to your computer and powered on.
- If the **New Hardware Wizard** window appears during the installation procedure, select in the upper right corner of the box to close the window, or select **Cancel**.

**Procedure**

1. Insert the supplied **Software and Documentation CD** into your CD-ROM drive. The **Software and Documentation CD** runs automatically and the installation window displays.
   a. If the installation window does not appear:
      - Select **Start** and then **Run**.
      - Type `X:\Setup.exe`, replacing “X” with the letter which represents your drive. Select **OK**.
      - If you use **Windows Vista**, **Windows 7** or **Windows 2008 Server R2** select **Start > All programs > Accessories > Run**.
        Type `X:\Setup.exe` replacing “X” with the letter which represents your drive and select **OK**.
   b. If the **AutoPlay** window appears in **Windows Vista**, **Windows 7** or **Windows 2008 Server R2**, select **Run Setup.exe** in the **Install or run program** field.
   c. In the **User Account Control** window, select **Continue** or **Yes**.
2. If necessary, from the **Select a language from the list below** drop-down menu, select a preferred language and select **Next**.
3. In the **Select Installation Type** window, select **Typical installation for a network printer** and select **Next**. The program will search the network for your machine.
   **Note** If your machine is not already connected to the computer, the **Connect Device** window will appear.
      - Select the **Printer Port** for your machine.
      - Select your machine in the **Printer Name** list and click **Next**.
      - The program will install the printer driver files. The **Setup Completed** message displays with the **I’d like to print a test page** checkbox. If you choose to print a test page, select the checkbox.
      - Select **Finish**.
4. Verify the test page prints at your machine.
If the Printer Driver does not Work

If the printer driver does not work properly, uninstall the driver and reinstall it.

For windows follow the steps below to uninstall the driver.

1. Make sure that the machine is connected to your computer and powered on.
2. From the Start menu, select Programs or All Programs > Xerox Printers > your printer driver name > Maintenance.
3. Select Remove and select Next. You will see a component list so that you can remove any item individually.
4. Select the components you want to remove and then select Next.
5. When your computer asks you to confirm your selection, select Yes. The selected driver and all of its components are removed from your computer.
6. After the software is removed, select Finish.

If you want to reinstall the driver over the currently installed driver via the provided Software and Documentation CD, insert the CD; the window with an overwriting confirmation message appears. Simply confirm it to proceed to the next step. Next steps are the same as the first installation you have made.

Wireless Setup (Phaser 3320DNI)

Note The machine will not connect to the wireless network while the network cable is attached.

1. Ensure your printer is powered on.
2. Insert the supplied Software and Documentation CD into your CD-ROM drive.
   The CD should run automatically and the installation window appear.
   • If the installation window does not appear, select the Start button and then Run. Type X:\Setup.exe, replacing “X” with the letter which represents your drive and select OK.
   • If you use Windows Vista, select Start > All programs > Accessories > Run, and type X:\Setup.exe. If the AutoPlay window appears in Windows Vista, select Run Setup.exe in the Install or run program field, and select Continue in the User Account Control window.
3. Select Install Software.
4. Select Wireless Setup and follow the wizard instruction to select and install the printer.
   If your printer is not already connected to the computer, the Connect Device screen will appear. After connecting the printer, select Next and follow the wizard instruction to install the printer.
5. After the installation is finished, select Finish. If your printer is connected to the network, a Test Print page will be printed.
The *Software and Documentation CD* that came with your machine provides you with the Driver files that allows you to use the CUPS driver or PostScript driver (only available when you use a machine which supports the PostScript driver) for printing on a Macintosh computer.

**Information Checklist**

Before starting please ensure that the following item is available and/or the task has been performed:

- Make sure that the machine is connected to your computer and powered on.

**Procedure**

1. Insert the supplied *Software and Documentation CD* into your CD-ROM drive.
2. Select the CD-ROM icon that appears on your Macintosh desktop.
3. Select the MAC_Installer folder.
4. Select the Installer icon.
5. Enter the password and select OK.
6. The Xerox Installer window opens. Select Continue.
7. Select Easy Install and select Install.
   - **Easy Install** is recommended for most users. All components necessary for machine operations will be installed.
   - If you select Custom Install, you can choose individual components to install.
8. When the message which warns that all applications will close on your computer appears, select Continue.
9. After the installation is finished, select Quit.
10. Open the Applications folder > Utilities > Print Setup Utility.
    - For Mac OS X 10.5~10.6, open the Applications folder > System Preferences and select Print & Fax.
11. Select Add on the Printer List.
    - For Mac OS X 10.5~10.6, press the “+” icon; a display window will pop up.
12. For Mac OS X 10.3, select the USB tab.
    - For Mac OS X 10.4, select Default Browser and find the USB connection.
    - For Mac OS X 10.5~10.6, select Default and find the USB connection.
13. For Mac OS X 10.3, if Auto Select does not work properly, select Xerox in Printer Model and your machine name in Model Name.
    - For Mac OS X 10.4, if Auto Select does not work properly, select Xerox in Print Using and your machine name in Model.
    - For Mac OS X 10.5~10.6, if Auto Select does not work properly, select Select a driver to use... and your machine name in Print Using.
   Your machine appears and is set as the default machine.
14. Select Add.
If the printer driver does not work properly uninstall the driver and reinstall it. Follow the steps below to uninstall the driver for Macintosh.

1. Make sure that the machine is connected to your computer and powered on.
2. Insert the supplied Software and Documentation CD into your CD-ROM drive.
3. Select the CD-ROM icon that appears on your Macintosh desktop.
4. Select the MAC_Installer folder.
5. Select the Installer icon.
6. Enter the password and select OK.
7. The Xerox Installer window opens. Select Continue.
8. Select Uninstall and click Uninstall.
9. When the message which warns that all applications will close on your computer appears, select Continue.
10. When the uninstall is done, select Quit.
You need to download the Linux software package from the Xerox website to install the printer software.

**Procedure for Installing the Linux Unified Driver**

1. Make sure that the machine is connected to your computer and powered on.
   You must log in as a super user (root) to install the machine software. If you are not a super user, ask your system administrator.
2. When the Administrator Login window appears, type in root in the Login field and enter the system password.
3. From the Xerox website, download the Unified Linux Driver package to your computer.
4. Select the Unified Linux Driver package and extract the package.
5. Select cdroot > autorun.
6. When the Welcome screen appears, select Next.
7. When the installation is complete, select Finish.

The installation program has added the Unified Driver Configuration desktop icon and the Unified Driver group to the system menu for your convenience. If you have any difficulties, consult the on-screen help that is available through your system menu or called from the driver package Windows applications, such as Unified Driver Configurator.

**Installing the SmartPanel**

1. Make sure that the machine is connected to your computer and powered on.
2. When the Administrator Login window appears, type in root in the Login field and enter the system password.
   
   **Note** You must log in as a super user (root) to install the machine software. If you are not a super user, ask your system administrator.
3. From the Xerox website, download the Smart Panel package to your computer.
4. Select the Smart Panel package and extract the package.
5. Select cdroot > Linux > smartpanel > install.sh.

**Installing the Printer Setting Utility**

1. Make sure that the machine is connected to your computer and powered on.
2. When the Administrator Login window appears, type in root in the Login field and enter the system password.
   
   **Note** You must log in as a super user (root) to install the machine software. If you are not a super user, ask your system administrator.
3. From the Xerox website, download the Printer Setting Utility package to your computer.
4. Select the **Printer Setting Utility** package and extract the package.
5. Select `cdroot > Linux > psu > install.sh`.

If the Printer Driver does not Work Properly uninstall the driver and reinstall it. Follow the steps below to uninstall the driver for Linux.

1. Make sure that the machine is connected to your computer and powered on.
2. When the **Administrator Login** window appears, type in `root` in the **Login** field and enter the **system password**.
   You must log in as a **super user** (root) to uninstall the printer driver. If you are not a **super user**, ask your system administrator.
3. Select the icon at the bottom of the desktop. When the **Terminal** screen appears, type in:
   
   ```
   root@localhost root#cd /opt/Xerox/mfp/uninstall/
   root@localhost uninstall#./uninstall.sh
   ```

4. Select **Uninstall**.
5. Select **Next**.
6. Select **Finish**.
Unix - Installing Drivers

Unix printer drivers are located on the Software and Documentation CD delivered with your machine. To use the Unix printer driver, you need to install the Unix printer driver package first, then set up the printer. The installation procedure is common for all variants of Unix OS mentioned.

Procedure for Installing the Unix Driver Package

1. Make sure that the machine is connected to your computer and powered on.
   
   `su -`
3. Copy the appropriate driver archive to the target Unix computer.
4. Unpack the Unix printer driver package name.
   For example, on IBM AIX, use the following command:
   
   `gzip -d < "package archive name" | tar xf -`
   
   The “binaries” folder consists of binz, install, share files and folders.
5. Change to the driver’s “binaries” directory.
   For example, on IBM AIX,
   
   `cd aix_power/binaries`
6. Run the install script.
   
   `./install`
   
   Install is the installer script file which is used to install or uninstall the Unix Printer Driver package.
   
   Use “chmod 755 install” command to give the permission to the installer script.
7. Execute the “./install-c” command to verify installation results.
8. Run “installprinter” from the command line. This will bring up the Add Printer Wizard window. Follow the procedures in Setting up the printer on page 45 to setup the printer.

   **Note** On some Unix OS, for example on Solaris 10, printers recently installed may not be enabled and/or may not accept jobs. In this case run the following two commands on the root terminal:

   `accept <printer_name>`
   
   `enable <printer_name>`

Setting up the printer

To add the printer to your Unix system, run “installprinter” from the command line. This will bring up the Add Printer Wizard window. Setup the printer in this window according to the following steps.

1. Type the name of the printer.
2. Select the appropriate printer model from the model list.
3. Enter any description corresponding to the type of printer in the **Type** field. This is optional.
4. Specify any printer description in the **Description** field. This is optional.
5. Specify the printer location in the **Location** field.
6. Type the IP address or DNS name of the printer in the **Device** textbox for network connected printers. On IBM AIX with **jetdirect Queue type**, only the DNS name is possible. It is not possible to enter a numeric IP address.

7. Queue type shows the connection as **lpd** or **jetdirect** in the corresponding list box. Additionally **usb** type is available on Sun Solaris OS.

8. Select **Copies** to set the number of copies.

9. Check the **Collate** option to receive copies already sorted.

10. Check the **Reverse Order** option to receive copies in the reverse order.

11. Check the **Make Default** option to set this printer as default.

12. Click **OK** to add the printer.

**Uninstalling the printer driver package**

*Note* The utility should be used if you need to delete a printer installed on the system.

1. Run the “**uninstallprinter**” command from the terminal. It will open the Uninstall Printer Wizard. The installed printers are listed in the drop-down list.

2. Select the printer to be deleted.

3. Click **Delete** to delete the printer from the system.

4. Execute the “**./install-d**” command to uninstall the whole package.

5. To verify removal results, execute the “**./install-c**” command.

6. To re-install it, use the command “**./install**” to reinstall the binaries.
Sharing your Machine Locally

If a Host computer is directly connected to the machine with a USB cable and is also connected to the local network environment, the client computer connected to the local network can use the shared machine through the host computer to print.

Follow the steps below to set up the computers to share your machine locally.

Windows

Host Computer Setup

1. Install your printer driver. Refer to Windows - Installing Driver on page 39.
2. From the Windows Start menu:
   - For Windows 2000, select Settings > Printers.
   - For Windows XP/2003, select Printers and Faxes.
   - For Windows 2008/Vista, select Control Panel > Hardware and Sound > Printers.
   - For Windows 7, select Devices and Printers.
   - For Windows Server 2008 R2, select Control Panel > Hardware > Devices and Printers.
3. Select your printer icon.
   - For Windows XP/2003/2008/Vista/7, select Printer Properties.
   - For Windows Server 2008 R2, from the Context menus, select the Printer properties.
   
   Note If the Printer properties item has ?, you can select other printer drivers connected with the selected printer.
4. Select the Sharing tab.
5. Check the Change Sharing Options checkbox.
6. Check the Share this printer checkbox.
7. Enter details in the Share Name field.
8. Select OK or Next.

Client Computer Setup

1. Install your printer driver. Refer to Windows - Installing Driver on page 39.
2. From the Windows Start menu select All programs > Accessories > Windows Explorer.
3. Enter the http:// IP address of the host computer and press Enter.
4. If the host computer requires a User name and Password, enter details in the User ID and password field of the host computer account.
5. Select the printer icon you want to share and select Connect.
   If a set up complete message appears, select OK.
6. Open the file you want to print and start printing.
Sharing your Machine Locally

Macintosh

The following steps are for Mac OS X 10.5–10.6. Refer to Mac Help for other OS versions.

**Host Computer Setup**

1. Install your printer driver. Refer to Macintosh - Installing Driver on page 41.
2. Open the Applications folder > System Preferences and select Print & Fax.
3. Select the printer to share in the Printers list.
4. Select “Share this printer”.

**Client Computer Setup**

1. Install your printer driver. Refer to Macintosh - Installing Driver on page 41.
2. Open the Applications folder, select System Preferences and select Print & Fax.
3. Press the “+” icon.
   A display window showing the name of your shared printer appears.
4. Select your machine and select Add.
Windows Printing

LPR Printing

Ensure Print Services for Unix is enabled

Follow the relevant steps below that are specific to your operating system:

**Windows XP**

1. From your workstation, load the *Software and Documentation CD* into your CD drive. If the CD autoruns, select **Exit**.
2. Verify that *Print Services for Unix* is loaded.
3. Select **Start**.
4. Select **Control Panel**.
5. Select **Add or Remove Programs**.
6. Select **Add/Remove Windows Components** in the left hand column.
7. Scroll down to **Other Network File and Print Services** and check on the checkbox to select it.
8. Select **Details**.
9. If it is not selected, check on the **Print Services for Unix** checkbox.
10. Select the **OK button**.
11. Select the **Next** button.
   - If *Print Services for Unix* is not installed, refer to instructions from Microsoft to install this service. When you are finished, return to this page.
12. Select the **Finish** button.

**Windows 2000/2003**

1. From the desktop, select the **My Network Places** icon and select **Properties**.
2. Select the **Local Area Connection** icon and select **Properties**.
3. Verify that the **Internet Protocol (TCP/IP)** protocol has been loaded. If this software is not present, install it using the documentation provided by Microsoft. When you are finished, return to this page.
4. Verify that *Print Services for Unix* is loaded:
   a. Select **Start**, **Settings** then **Control Panel**.
   b. Select the **Add/Remove Programs** icon.
   c. Select **Add/Remove Win Components** in the far left column.
   d. Select **Other Network File and Print Services**.
   e. Select **Details**.
   f. Check the **Print Services for Unix** checkbox. If *Print Services for Unix* is not installed, refer to instructions from Microsoft to install this service. When you are finished, return to this page.
5. Select the **OK button**.
6. Select the **Next** button.
7. Select the Finish button.
8. Close the **Add/Remove Programs** window.

**Windows Vista**

1. Select **Start** > **Control Panel** > **Program** and select **Programs and Features**.
2. Select **Turn Windows Features on and off**.
3. In the **Windows Features** window, expand the **Print Services** menu.
4. Check the **LPR Port Monitor** checkbox to enable the service.
5. Select the **OK** button. Your computer may need to restart.

**Windows 7**

1. Select **Start**, select **Control Panel**.
2. Select **Hardware and Sound**, select **Programs**.
3. Select **Programs and Features**.
4. Select **Turn Windows Features on and off** from the menu on the left.
5. A Windows Features dialog displays. Select the ‘+’ sign for **Printer and Document Services**.
6. Check the box for **LPR Port Monitor** to enable the service.
7. Select the **OK** button. Your computer may need to restart.

**Windows 2008**

1. Select **Start**, select **Administrative Tools**.
2. Select **Print Management**.
3. Select the ‘+’ sign for **Print Servers**. Select the print server to which you want to add the printer and select **Add Printer**.
4. Check the box for **LPR Port Monitor** to enable the service.
5. Select the **OK** button. Your computer may need to restart.

**Install Printer Driver**

1. From the Windows **Start** menu
   - For **Windows 2000/2003** - select **Settings** then **Printers**.
   - For **Windows XP** - select **Printers and Faxes**. If you cannot see this option in the **Start** menu, then select **Start**, followed by **Control Panel** first.
   - For **Windows Vista** - select **Control Panel** then **Printers**.
   - For **Windows 7** - select **Hardware and Sound** then select **Devices and Printers**.
   - For **Windows 2008** - select **Control Panel** then select **Printers**. From the **File** drop-down menu select **Run as administrator**.
2. For:
   - **Windows XP/2000/2003**:
     a. Select **Add Printer** in the far left column.
     b. Select the **Next** button.
Windows Vista:
a. Select Add Printer.

Windows 7:
a. Select Add a Printer.

Windows 2008:
a. Select Add Printer.

3. For:
   - Windows 2000 - select Local Printer.
   - Windows XP/2003/2008 - select Local Printer attached to this computer.
If already selected, select Automatically detect and install my Plug and Play printer to deselect it.
   - Windows Vista - select A printer attached to my computer.
   - Windows 7 - select Add a Local Printer.

4. Select the Next button.

5. Select Create a new port.

6. Select the following option from the Type of Port pull down menu:
   - For Windows 2000/2003 select LPR.
   - For Windows XP/Vista/7 select LPR Port.

7. Select the Next button.

8. Enter the IP Address of the printer.

9. Enter details in:
   - Print Queue name for Windows Vista.
   - Port name for Windows 7.

10. Select the OK button.

11. You will be prompted for a Printer Driver. Select Have Disk.

12. Select the Browse button.

13. Locate the Drivers folder on the CD and select the required Printer Driver file .inf.

14. Select the Open button.

15. Select the OK button.

16. Select the Printer Model from the list.

17. Select the Next button.

18. The Name your Printer screen appears.

19. To configure the settings:
   a. Enter details in the Printer Name field.
   b. If you want to set this printer as your default printer, select Set as default. For Windows Vista users, go to step 25.

20. Select the Next button.

21. The Printer Sharing Screen appears.
   If you will be sharing this printer with other clients, then:
   a. Select:
Windows Printing

- Share Name: for Windows XP/2003/Vista/7.
  b. Enter details in the Share Name field.

22. Select the Next button.
23. Enter a Location name and Comment if required.
24. Select the Next button.
25. Select Yes or Print Test Page to print a test page.
26. Select the Next button to close the Test Page window.
27. Select the Finish button. The printer driver will install.
28. Verify that the test page is printed at the machine.

Internet Printing Protocol (IPP) Port

The Internet Printing Protocol (IPP) defines a standard protocol for printing as well as managing print jobs, media size, resolution, and so forth. IPP can be used locally or over the Internet, and also supports access control, authentication, and encryption, making it a much more capable and secure printing solution than older ones.

Note IPP Printing is enabled by default.

How to Enable the IPP Port

1. At your workstation, open the web browser and enter the IP Address of the machine in the Address Bar.
2. Select Properties.
3. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login.
4. Click Properties.
5. In the Network Settings link select Raw TCP/IP, LPR, IPP in the directory tree.
6. In the Internet Printing Protocol (IPP) area:
   a. For IPP Protocol, select the Enable checkbox. The Printer URI displays the http:// IP address of the machine. Enter the required printer name in the Printer Name area.
   b. Select the Advanced button. Enter the required information for IPP Attribute. Select the IPP Security tab. From Authentication Type drop-down menu, select one of the following types of authentication scheme to use when printing with IPP. These schemes are only used if the printer has both a user name and password entered for IPP:
      - None
      - Basic - this scheme requires the printer to authenticate the person sending the print job. The printer only services the request if the name and password provided by the user match the values stored in the printer.
      - Digest - this scheme requires the printer to authenticate the person sending the print job using a single checksum password scheme. The printer only services the request if the name and password provided by the user match the values stored in the printer.
   c. If you have selected Basic or Digest, select the Add button. Enter the user name for the printer in the User Name field.
   d. Enter the password in the Password and Confirm Password fields.
7. Select **Apply** to save the changes.

**Install Printer Driver**

1. Follow the steps below that are specific to your operating system:
   - **Windows XP**
     From your workstation:
     a. Select **Start**.
     b. Select **Network Connections**.
   - **Windows 2000/2003**
     From your workstation:
     a. Select the **My Network Places** icon.
     b. Select **Properties**.
   - **Windows 7**
     From your workstation:
     a. Select **Start**, select **Control Panel**.
     b. Select **Network and Internet**.
     c. Select **Network and Sharing Centre. Go to step 4.**
   - **Windows 2008**
     From your workstation:
     a. Select **Start**, select **Control Panel**.
     b. Select **Printers**.
     c. Select **File**, select Run as administrator. Go to step 6.

2. Select the **Local Area Connection** icon.

3. Select **Properties**.

4. Ensure that the **Internet Protocol (TCP/IP)** protocol has been loaded and ensure the checkbox is checked.

5. For:
   - **Windows 2000/2003** - select **Settings** then **Printers**.
   - **Windows XP** - select **Printers and Faxes**. If you cannot see this option in the **Start** menu, then select **Start**, followed by **Control Panel** first.
   - **Windows Vista** - select **Add a Local Printer**.
   - **Windows 7** - select **Start**, select **Control Panel**, select **Hardware and Sound**, then **Devices and Printers**.

6. Select **Add Printer** in the far left column.
   For **Windows 7** select **Add a network, wireless or Bluetooth printer**.

7. The **Add Printer Wizard** window will appear.

8. In the **Local or Network Printer**, ensure that **A network printer**, or a printer attached to another computer is selected and select the **Next** button.

9. The following screen will appear:
   - **Specify a Printer** for Windows XP.
10. To create an IPP printer, select Connect to a printer on the Internet.
11. Type HTTP:// followed by the printer’s fully qualified Domain name or IP Address in the URL field. The Printer Name can be either the Host Name or the SMB Host Name as shown on the machine Configuration Report, depending on the name resolution used by your network (WINS or DNS).
12. Select the Next button.
13. Select the OK button to install the printer driver.
14. Select the Have Disk button and browse to the location of the printer driver and select the OK button.
15. Select the Printer Model and Select the OK button.
16. Select Yes if you wish to make this the default printer.
17. Select the Next button.
18. Select the Finish button.

Raw TCP/IP Printing (Port 9100)

Raw TCP/IP is a printing protocol that is similar to LPR printing. Also known as a direct TCP/IP connection or sockets interface, it sends information directly to the machine and does not require a Line Printer Daemon (LPD). The advantages are that connections stay open for multiple print files and spooling is not needed, therefore, printing is faster and more reliable than LPD printing. Raw TCP/IP printing is contained in Windows 2000 and other third-party applications and operating systems.

Note Raw TCP/IP Printing is enabled by default for port 9100.

Information Checklist

See the Information Checklist in Configure Static IPv4 Addressing at the Machine on page 24.

How to Configure Port 9100

1. At your workstation, open the web browser and enter the IP Address of the machine in the Address Bar.
2. Select Properties.
3. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login.
4. Click Properties.
5. In the Network Settings link select Raw TCP/IP, LPR, IPP in the directory tree.
6. In the Raw TCP/IP Printing area:
   a. Select Enable.
   b. For Port Number, enter the required port number (1 - 65535).
7. Select Apply to save the changes or Undo to return the settings to their previous values.

Note The settings are not applied until you restart the machine.

Install Printer Driver

Refer to Windows - Installing Driver on page 39.
USB Printing

Information Checklist

Before starting please ensure that the following items are available and/or the tasks have been performed:

- A standard USB peripheral cable.
- A workstation or laptop that supports USB connectivity.

Procedure

1. Connect the USB cable from your computer to the USB port at the back of the machine.
2. Insert the supplied Software and Documentation CD into your CD-ROM drive. The Software and Documentation CD runs automatically and the installation window displays.
   a. If the installation window does not appear:
      - Select Start and then Run.
      - Type X:\Setup.exe, replacing “X” with the letter which represents your drive. Select OK.
      - If you use Windows Vista, Windows 7 or Windows 2008 Server R2 select Start > All programs > Accessories > Run.
        Type X:\Setup.exe replacing “X” with the letter which represents your drive and select OK.
   b. If the AutoPlay window appears in Windows Vista, Windows 7 or Windows 2008 Server R2, select Run Setup.exe in the Install or run program field.
   c. In the User Account Control window, select Continue or Yes.
3. If necessary, from the Select a language from the list below drop-down menu, select a preferred language and select Next.
4. In the Select Installation Type window, select Typical installation for a local printer and select Next. The program will search the network for your machine.
   - Select your machine in the Printer Name list and click Next.
   - The program will install the printer driver files. The Setup Completed message displays with the I’d like to print a test page checkbox. If you choose to print a test page, select the checkbox.
   - Select Finish.
5. Verify the test page prints at your machine.
Configure the Windows Printer Driver

Manual Printer Driver Configuration

To configure the printer driver without using Bi-Directional communication:

Follow the steps below that are specific to your operating system:

1. Select the Windows Start menu.
2. Select one of the following for your Operating System:
3. For:
   - Windows 2008/Vista, select Control Panel > Hardware and Sound > Printers.
   - Windows 7, select Control Panel > Hardware and Sound > Devices and Printers.
   - Windows Server 2008 R2, select Control Panel > Hardware > Devices and Printers.
   - Windows 7 and Server 2008 R2, from context menus, select the Printer properties.
4. Right click the printer icon and then select Preference.
   For Windows 7, right click the printer icon and then select Printing Preferences.
5. Select each tab and change any default printer settings as required.
6. Select Apply.
7. Select OK.

For further printing options refer to the Phaser 3320DN/3320DNI User Guide.

Bi-Directional Support

Follow the steps below that are specific to your operating system:

1. Select the Windows Start menu.
2. Select one of the following for your Operating System:
3. For:
   - Windows Vista, select Control Panel > Hardware and Sound > Printers.
   - Windows 7, select Control Panel > Hardware and Sound > Devices and Printers.
   - Windows Server 2008 R2, select Control Panel > Hardware > Devices and Printers.
4. For Windows XP/2003/2008/Vista, select the printer icon and select Properties.
   For Windows 7 right click on the printer icon and select Printer Properties.
5. Select the Ports tab.
6. Check the **Enable bidirectional support** checkbox.
   Bi-directional communication automatically updates the printer driver with the printer’s installed options. The driver’s *Printing Preferences* will report information about the printer’s operational status, active jobs, completed jobs and paper status.

7. Select **Apply**, then **OK**.
TCP/IP Printing (OSX)

Information Checklist

Before starting please ensure that the following items are available and/or the tasks have been performed:

- The TCP/IP settings must be correctly configured on the machine.
- Locate the Software and Documentation CD delivered with your machine.

Install the Printer Driver

1. Load the Software and Documentation CD into your CD drive.
2. Open the CD and select the required language, if necessary.
3. Select the Drivers folder.
4. Select the Mac folder.
5. Select the folder containing the drivers for your Mac OS version.
6. Select the machine model.dmg file.
7. Select the machine model.pkg file.
8. The Welcome to the Installer dialog box appears.
9. Select Continue.
10. Select Continue and then Agree to accept the License Agreement.
11. Select the Volume (if necessary) where you want to install the printer. Select Continue.
12. Select the Install button.
13. Select the Close button.
15. Select the Hard Drive icon on the Desktop.
16. Select Applications.
17. Select Utilities.
19. To add a new printer, select:
   - Add.
   or
   - Printers menu then Add Printer.
20. Select IP Printing from the top menu.
21. Select Internet Protocol Printing or LPD/LPR Printing from the next menu.
22. Enter the IP Address of the printer.
23. Enter the Print Queue Name. (You may leave this blank.)
24. Select Xerox from the Printer Model list.
25. Select your **Printer Model** from the list.
26. Select **Add**. The machine will appear in the **Printer List**.
27. Select the **Printer** and select **Show Info**.
28. Select **Installable Options**.
29. Select the options as installed on your machine.
   
   If you want to use the **Save Job for Reprint** feature, then make sure that **Job Storage** is set to **Installed**.
30. Select **Apply Changes**.
31. Close the **Printer Info** box.
32. Print a document to verify that the printer is installed correctly.

**Configure your Apple Mac Printer Driver**

**Information Checklist**

Before starting please ensure that the following item is available and/or the task has been performed:

- The printer driver is installed on your Macintosh operating system.

**Procedure - Changing Printer Settings**

You can use advanced printing features provided by your machine.

Open an application and select **Print** from the **File** menu. The machine name, which appears in the printer properties window may differ depending on the machine in use. Except for the name, the composition of the printer properties window is similar to the following.

**Note** The setting options may differ depending on printers and Macintosh OS version.

**Layout**

The **Layout** tab provides options to adjust how the document appears on the printed page. You can print multiple pages on one sheet of paper. Select **Layout** from the **Orientation** drop-down menu to access the following features:

- **Pages per Sheet** - this option determines how many pages are printed on one page.
- **Layout Direction** - this option allows you to select the printing direction on a page similar to the examples on the display.
- **Border** - this option allows you to create a border around each page on the sheet.
- **Two-Sided** - this option allows you to print on both sides of the paper.
- **Reverse Page Orientation** - this option allows you to rotate the page 180 degrees.

**Graphics**

The **Graphics** tab provides options for selecting **Resolution**. Select **Graphics** from the **Orientation** drop-down menu to access the graphic features:
• **Resolution** - this option allows you to select the printing resolution. The higher the setting, the sharper the clarity of printed characters and graphics. The higher setting also may increase the time it takes to print a document.

**Paper**

Set **Paper Type** to correspond to the paper loaded in the tray from which you want to print. This will let you get the best quality printout. If you load a different type of print material, select the corresponding **paper type**.

**Printer Features**

The **Printer Features** tab provides **Reverse Duplex Printing** and **Fit to Page** options. Select **Printer Features** from the **Orientation** drop-down menu to access the following features:

- **Reverse Duplex Printing** - this option allows you to select general print order compared to duplex print order. If this option does not appear, your machine does not have this feature.
- **Fit to Page** - this option allows you to scale your print job to any selected paper size regardless of the document size. This can be useful when you want to check fine details on a small document.

**Toner Save Mode**

Selecting this option extends the life of your toner cartridge and reduces your cost per page without a significant reduction in print quality.

**Printer Setting** - select this option to allow toner settings to be determined by the setting you have made on the control panel of the printer.

- **On** - select this option to allow the printer to use less toner on each page.
- **Off** - if you do not need to save toner when printing a document, select this option.

**Printing multiple pages on one sheet of paper**

You can print more than one page on a single sheet of paper. This feature provides a cost-effective way to print draft pages.

- Select **Layout** from the **Orientation** drop-down menu. In the **Pages per Sheet** drop-down menu, select the number of pages you want to print on one sheet of paper.

**Printing on both sides of paper**

You can print on both sides of the paper. Before printing in the duplex mode, decide on which edge you will be binding your finished document. The binding options are, as follows:

- **Long-Edge Binding** - this option is the conventional layout used in book binding.
- **Short-Edge Binding** - this option is the type often used with calendars.

- Select **Layout** from the **Orientation** drop-down menu. Select a binding orientation from **Two Sided Printing** option.
This chapter describes how to configure the Security features for the machine.

The following topics are mentioned in this chapter:

- **Security Settings** on page 62
- **Machine Digital Certificate Management** on page 64
- **SNMP** on page 69
- **SNMPv3** on page 71
- **IP Sec** on page 72
- **IP Filtering** on page 73
- **802.1X Authentication** on page 75
- **Display Network Settings** on page 77

**Security @ Xerox**

For the latest information on securely installing, setting up and operating your machine see the Xerox Security Information web site located at [www.xerox.com/security](http://www.xerox.com/security).
Security Settings

To prevent unauthorized changes to printer settings, ensure a login ID and password is entered in the System Administrator area.

Administrator Accounts

1. At your workstation, open the web browser and enter the IP Address of the machine in the Address Bar.
2. Press Enter.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login.
5. Click Properties.
6. In the Security link on the left hand side select the System Security link.
7. Select System Administrator.
8. If required, enter Administrator details for:
   • Name
   • Phone Number
   • Location
   • E-mail Address
9. The WebUI Access Control checkbox controls access to the Internet Services screen.
10. To change the Administrator Password, select the Change Password box and enter the required Login ID and password. The default is admin and 1111 respectively.
11. Select the Advanced button for Advanced Access Control.
12. Select Protect Login IPv4 Address if required, and enter the required login IP address that you want to protect in the IPv4 Address box.
13. Select the required option for Login Failure Policy. The options are: Off, 3 times and 5 times.
14. Select the required number of minutes from the Auto Logout menu.
15. Select Security Settings Reset to enable this option if required.
16. Select Save.
17. To control access to the machine control panel, select the Enable box to enable LUI Access Control.
18. Select Apply to save the changes.
19. Select OK when the acknowledgement message displays.

Feature Management

The Feature Management screen allows you to access the Firmware Upgrade, Physical Ports and Network Protocols controls that are available on the machine.

1. At your workstation, open the web browser and enter the IP Address of the machine in the Address Bar.
2. Press Enter.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login.
5. Click Properties.
6. In the Security link on the left hand side select the System Security link.
7. Select the Feature Management link in the directory tree.
8. To enable or disable a control, check or uncheck the box in the Firmware Upgrade, Physical Ports and Network Protocols areas.
   - For LPR/LPD Protocol, enter the required port number. (The default is 515).
   - For Raw TCP/IP Printing Protocol, enter the required port number. (The default is 9100).
9. Click Apply to save the changes.

**Restart Device**

The Restart Device screen allows you to reboot the machine remotely from your desktop.

*Note*  When the machine is restarted, the Network Controller will take some time to restart. The network connectivity will be unavailable during this time.

1. At your workstation, open the web browser and enter the IP Address of the machine in the Address Bar.
2. Press Enter.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login.
5. Click Properties.
6. In the Security link on the left hand side select the System Security link.
7. Select the Restart Device link in the directory tree.
8. To reboot the machine select the required Restart Now button.
9. The Do you really want to restart the device screen appears. Click Yes. The machine will reboot. Internet Services may be unavailable for several minutes while the machine reboots.
Machine Digital Certificate Management

The following topics are covered in this section:

- **Overview** on page 64
- **Information Checklist** on page 64
- **Access the Machine Digital Certificate Management Screen** on page 64
- **Create a Self Signed Certificate** on page 65
- **Install a CA Signed Device Certificate** on page 65
- **Enable Secure Connection** on page 67

**Overview**

The machine can be configured for secure access with the SSL (Secure Socket Layer) protocol via Digital Certificates. SSL enables secure access to the machine.

To enable SSL on a machine, it needs to have its own digital certificate. When clients make a request to the machine, it exports the certificate to provide an encrypted channel.

There are two options available to obtain a server certificate for the machine:

- Have the machine create a Self Signed Certificate
- Create a request to have a Certificate Authority sign a certificate that can be uploaded to the machine.

A self-signed certificate means that the machine signs its own certificate as trusted and creates the public key for the certificate to be used in SSL encryption.

A certificate from a Certificate Authority or a server functioning as a Certificate Authority (for example Windows 2000 running Certificate Services) can be uploaded to the machine.

*Note* A separate request is required for each Xerox machine.

**Information Checklist**

Ensure that the machine is configured with the following items:

- An IP Address or Host Name must be configured on the machine.
- DNS must be enabled and configured on the machine.

*Note* This is used to set the start time for self signed certificates.

**Access the Machine Digital Certificate Management Screen**

1. At your workstation, open the web browser and enter the *IP Address* of the machine in the Address Bar.
2. Press *Enter*.
3. Select the *Properties* icon.
4. If prompted, enter the *Administrator User Name* (admin) and *Password* (1111), and select *Login*.
5. Click Properties.
6. In the Security link on the left hand side select the Network Security link.
8. Select Add.

Select one of the following options:

- Install/Create Device Certificate or CSR. The following options are available:
  - Create a Self-signed Device Certificate
  - Install CA signed Device Certificate
  - Create Certificate Signing Request (CSR)
  - Install Root Certificate

**Create a Self Signed Certificate**

1. In the Install/Create New Certificate area select Create a Self Signed Device Certificate.
2. Select Next.
3. In the Self Signed Certificate area:
   a. Enter a Friendly Name to identify the certificate.
   b. In the 2 Letter Country Code field enter the Country Code that represents the country in which the machine is located. The country code must be entered as a two-character ISO 3166 country code.
   c. If required, enter details in the following fields:
      - State/Province Name
      - Locality Name
      - Organization Name
      - Organization Unit
   Information entered for these options should describe the machine as per the X500 directory scheme but can be any value which is meaningful to the customer to identify the machine.
   
   **Note** The Common Name is taken from the machine’s IP Address/Host Name and Domain Name.
   d. In the Valid Period box, enter the number of days that the certificate should be valid. Once the specified time is reached, the certificate will expire. The start time is based on the current machine system time so it is important that the time is set correctly on the machine.
   e. Enter the E-mail Address of the Administrator who is responsible for the secure management of the machine.
4. Select the Next button. A message displays to show the success of the certificate creation.
5. Click the Close button. The certificate displays in the Certificate Management area.
6. Follow the steps in Enable Secure Connection on page 67.

**Install a CA Signed Device Certificate**

1. In the Install/Create New Certificate area, select Install CA Signed Device Certificate.
2. Select Next.
3. In the **Certificate Information** area:
   a. Enter a **Friendly Name** to identify the certificate
   b. Enter the required **Private Password** and **Confirm Password**.
   c. In the **CA Signed Certificate** area click **Browse** to find the certificate file on your computer.
      Select the file and click **OK**.
   d. Click **Next**.
4. Select the **Apply** button to accept the changes.
   If prompted, enter the **Administrator User Name** (**admin**) and **Password** (**1111**), and select **OK**.
5. If successful, the **Current Status** area will display the message, “**A CA Signed Certificate is established on this machine.**”
6. Follow the steps in **Enable Secure Connection** on page 67.

**Create a Certificate Signing Request**

1. In the **Install/Create New Certificate** area select **Create Certificate Signing Request**.
2. Select **Next**.
3. In the **Certificate Signing Request (CSR)** area:
   a. Enter a **Friendly Name** to identify the request.
   b. In the **2 Letter Country Code** field enter the **Country Code** that represents the country in which the machine is located. The country code must be entered as a two-character ISO 3166 country code.
   c. If required, enter details in the following fields:
      • **State/Province Name**
      • **Locality Name**
      • **Organization Name**
      • **Organization Unit**
      Information entered for these options should describe the machine as per the X500 directory scheme but can be any value which is meaningful to the customer to identify the machine.
   d. Enter the **E-mail Address** of the Administrator who is responsible for the secure management of the machine.
4. Click **Next**.
5. Select the **Apply** button to accept the changes.
   If prompted, enter the **Administrator User Name** (**admin**) and **Password** (**1111**), and select **Login**.
6. The **Certificate Signing Request (CSR)** form will appear. In the **Certificate Signing Request (CSR)** area:
   a. Select the **Download** button.
7. Select **Save** and save the file to your computer. The file is saved as a simple text file, named csr.pem (Privacy Enhanced Mail).
8. Send the file to your Certificate Authority for digital signing.
9. When you receive the signed certificate back from the Certificate Authority, upload the certificate to the machine:
   a. Return to the **Digital Certificate** screen in the Internet Services Network Security menu.
b. In the **Certificate Management List**, select the **Certificate Signing Request** (CSR) you created in the previous step. Click **Edit**.

c. In the **Upload Machine Digital Certificate** area select **Browse**.

d. Browse to the signed certificate file on your PC and select the **Open** button.

e. Select the **Apply** button.

f. If successful, the Current Status will display the message **“A Signed Certificate is established on this machine.”**

**Note** For the upload to be successful, the signed certificate must match the CSR created by the machine and must be in a format that the machine supports.

**Install Root Certificate**

1. In the **Install Root Certificate** area select **Install new Root Certificate**.

2. Select **Next**.

3. In the **Install Certificate** area:
   a. Enter a **Friendly Name** to identify the certificate.
   
   b. In the **Root Certificate** area click **Browse** to find the certificate file on your computer. Select the file and click **OK**.

   c. **Click Next**.

4. Select the **Apply** button to accept the changes.

   If prompted, enter the **Administrator User Name** (admin) and **Password** (1111), and select **Login**.

5. If successful, the **Current Status** area will display the message **“Root Certificate has successfully been installed.”**

6. Follow the steps in **Enable Secure Connection** on page 67.

**Enable Secure Connection**

Once the machine has a machine Server Certificate, you can enable Secure Connection.

1. At your workstation, open the web browser and enter the **IP Address** of the machine in the Address Bar.

2. Press **Enter**.

3. Select the **Properties** icon.

4. If prompted, enter the **Administrator User Name** (admin) and **Password** (1111), and select **Login**.

5. **Click Properties**.

6. In the **Security** link on the left hand side select the **Network Security** link.

7. Select the **Secure Connection** link.

8. Click the **Select Certificate** button and select the required certificate. Click **Select**. The certificate displays in the **Certificate for Secure Connection** area.

9. In the **Secure HTTP** area, select the required option in the **HTTPs** menu. Select **Both HTTP and HTTPs** to enable Secure IPP or select **HTTPs Only**.

10. If you selected **Both HTTP and HTTPs**, select **On** from the **IPPs** menu if required.

11. Select **Apply** to save the changes.
12. Close your web browser and then access the Internet Services screen again. The Security warning will display. Self-signed certificates cause browsers to display messages which question the trust of the certificate. Select the OK button to continue.

**Edit or Delete a Certificate**

1. At your workstation, open the web browser and enter the *IP Address* of the machine in the Address Bar.
2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login.
5. Click Properties.
6. In the Security link on the left hand side select the Network Security link.
7. Select the Digital Certificate link. The Certificate Management page displays with a list of the certificates installed on this machine.
8. Select the box next to the Friendly Name of the certificate that you want to edit or delete.
   - Select the Edit button to edit the certificate. Make the required changes and click Apply.
   - Select the Delete button to delete the certificate, and click Yes to confirm.
SNMP

SNMP (Simple Network Management Protocol) settings can be configured via Internet Services.

1. At your workstation, open the web browser and enter the IP Address of the machine in the Address Bar.
2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login.
5. Click Properties.
6. In the Network Settings link select the SNMP link.
7. Select SNMPv1/v2.
   a. Select the Enable checkbox to enable SNMPv1/v2 Protocol.
   b. Select the required Community Name from the list, or click Add to add a new SNMP Community. The Add pop up menu appears.
      • Enter the required Name for the SNMP Community.
      • Select the required Access Permission.
8. Select Apply to save the changes.
9. Select OK when the acknowledgement message displays.

SNMP Traps

You can specify IPv4 Trap Destination Addresses.

1. From the SNMP page, in the SNMP Traps area select Add.
2. In the Trap Destination Address area, enter details in the IPv4 Address and Port Number fields.
3. In the Traps area, enter the name in the TRAP Community Name field.
4. For Traps to be received check the boxes to select the following Traps:
   • Printer Traps.
   • Cold Start Generic Traps.
   • Warm Start Generic Traps.
   • Authentic Failure Traps.

   Note When Authentication Failure Traps is enabled, the machine will generate a trap for every SNMP request that is received by the machine which contains an invalid community name.
5. Select Apply to save the changes.
6. Select OK when the acknowledgement message displays.

To Edit Community Names or SNMP Traps

1. From the SNMP page, in the Community Names or SNMP Traps area select the name or address you want to edit.
2. Select Edit.
3. Change the required options and select Apply to save the changes.
To Delete Community Names or SNMP Traps

1. From the **SNMP** page, in the **Community Names** or **SNMP Traps** area select the name or address you want to delete.
2. Select **Delete**.
3. Select **OK**.

*Note* Changes made to the GET or SET community names for this machine will require corresponding GET or SET community name changes for each application which uses the SNMP protocol to communicate with this machine (e.g. Xerox CentreWare Web, any third party network management applications, etc.).
SNMPv3 can be enabled to create an encrypted channel for secure machine management.

1. At your workstation, open the web browser and enter the IP Address of the machine in the Address Bar.
2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login.
5. Click Properties.
6. In the Network Settings link select the SNMP link.
7. Select the SNMPv3 link. The SNMPv3 page displays.
8. In the Setup area:
   a. Click the Enable box to enable SNMPv3 Protocol.
   b. In the Authentication area, enter the required User Name.
   c. Enter a password in the Authentication Password field.
   d. Enter the password again in the Confirm Password field.
   e. For Authentication Algorithm, select either MD5 or SHA.
   f. Enter a password in the Privacy Password field.
   g. Enter the password in the Confirm Password field.
   h. The Privacy Algorithm displays.
9. Select Apply to save the changes.
10. Select OK when the acknowledgement message displays.
IP Sec

IP Sec (IP Security) is comprised of the IP Authentication Header and IP Encapsulating Security Payload protocols, that secure IP communications at the network layer of the protocol stack, using both authentication and data encryption techniques. The ability to send IP Sec encrypted data to the printer is provided by the use of a public cryptographic key, following a network negotiating session between the initiator (client workstation) and the responder (printer or server). To send encrypted data to the printer, the workstation and the printer have to establish a Security Association with each other by verifying a matching password (shared secret) to each other. If this authentication is successful, a session public key will be used to send IP Sec encrypted data over the TCP/IP network to the printer. Providing additional security in the negotiating process, SSL (Secure Sockets Layer protocols) are used to assure the identities of the communicating parties with digital signatures (individualized checksums verifying data integrity), precluding password guessing by network sniffer.

Enable IP Sec

This procedure requires that you have a Shared Secret available.

IP Sec cannot be enabled until Secure Connection is enabled on the machine. For instructions, refer to Enable Secure Connection on page 67.

1. At your workstation, open the web browser and enter the IP Address of the machine in the Address Bar.
2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login.
5. Click Properties.
6. In the Security link on the left hand side select the Network Security link.
8. Click Enable to enable the IP Sec protocol.
9. Enter the Shared Secret and Confirm Shared Secret.
10. Select Apply to save the settings. Select OK when the acknowledgement message displays.
11. The IP Sec Current Status confirms the status of the IP Sec protocol.
12. To change the Shared Secret, click the Change Shared Secret button and enter the new Shared Secret information.
13. Click Apply to save the changes.
14. To clear IP Sec connections, click the Clear All IPSec Connections button. The 'Do you really want to clear all IPSec connections' message appears. Click Yes. The 'All IPSec connections have been cleared' message appears. Click OK to close.
IP Filtering

Overview

The IP Filtering is a security feature that allows you to control access to Internet Services. IP Filtering allows you to prevent unauthorized access by TCP/IP (Transmission Control Protocol/Internet Protocol).

The IP Filtering feature provides security to the machine, by allowing you to register the IP addresses permitted to communicate with the machine. This feature is used to prevent Raw TCP/IP Printing, LPR/LPD, HTTP, IPP and SNMP from unauthorized users.

Enable IP Filtering

1. At your workstation, open the web browser and enter the IP Address of the machine in the Address Bar.
2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login.
5. Click Properties.
6. In the Security link on the left hand side select the Network Security link.

For IPv4 Filtering

7. Select the IPv4 link.
8. Select the IPv4 Filtering Enabled checkbox.
9. In the IP Filtering Rules area select the Add button.
10. In the IPv4 Address Range enter the Start IPv4 Address and the End IPv4 Address that you want to allow access to the device.
11. Select the options that you want to allow access to in Services to Accept.
12. Select the required Priority.
13. Select Apply to save the changes.
14. Select OK when the acknowledgement message displays.

For IPv6 Filtering

15. Select the IPv6 link.
16. Select the IPv6 Filtering Enable checkbox.
17. In the IP Filtering Rules area select Add.
18. Enter the IPv6 Address/Prefix that you want to allow access to the device, in the form of the CIDR convention. The prefix indicates the number of leftmost bits to be referenced.
19. Select the options that you want to allow access to in Services to Accept.
20. Select the required Priority.
21. Select Apply to save the changes.
22. Select OK when the acknowledgement message displays.
Enable MAC Filtering

1. At your workstation, open the web browser and enter the IP Address of the machine in the Address Bar.
2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login.
5. Click Properties.
6. In the Security link on the left hand side select the Network Security link.
7. Select MAC Filtering in the directory tree. The MAC Filtering page displays.
8. Select the MAC Filtering Enable box.
9. In the MAC Address to Filter Out area select the Add button.
10. Enter the MAC address that you want to filter out.
11. Select Apply to save the changes.
12. Select OK when the acknowledgement message displays.
802.1X Authentication

This is the procedure to follow to install and setup 802.1X Authentication:

- **Overview** on page 75
- **Information Checklist** on page 75
- **Enable 802.1X at the machine** on page 75

**Overview**

The Xerox machine supports IEEE 802.1X Authentication via Extensible Authentication Protocol (EAP). IEEE 802.1X ensures all machines on the network are authenticated and authorized to use the network. 802.1X can be enabled for machines connected through wired Ethernet networks.

The Administrator can configure the machine to use one EAP type. EAP types supported on the machine are:

- EAP-MD5
- PEAP
- EAP-MSCAPv2
- TLS

**Information Checklist**

Before starting please ensure that the following items are available and/or the tasks have been performed:

- 802.1X authentication must be supported on the network where the machine is connected.
- Ensure that your 802.1X Authentication Server and authentication switch are available on the network.
- Create a **User Name** and **Password** on your Authentication Server which will be used to authenticate the machine.
  
  **Note** Write down the **User Name** and **Password** and keep in a safe place.

**Enable 802.1X at the machine**

1. Press the **Menu** button on the **control panel**.
2. Use the arrow buttons to scroll to **Network Setup** and press **OK**.
3. Enter the **Administrator Password** using the arrow buttons. The default is **1111**. Refer to **Entering a password**: on page 14.
4. Press the **OK** button.
5. Press the arrow buttons to select **802.1x** and press **OK**.
6. Press the arrow buttons to select **On**; press **OK**.
7. Press the arrow buttons to highlight one of the following for the **Authentication Method**:
   - **EAP-MD5**
802.1X Authentication

- EAP-MSCHAPv2
- PEAP
- EAP-TLS

8. Press OK.
9. Enter the User Name using the arrow buttons and press OK.
10. Enter the Password using the arrow buttons and press OK.
11. The screen will display Saved and the machine will reboot.

Enable 802.1X using Internet Services

Authentication via TLS requires a Device Certificate to be configured or uploaded to the machine. For instructions refer to Access the Machine Digital Certificate Management Screen on page 64.

Authentication via PEAP and TLS requires a Root Certificate to be uploaded to the machine. For instructions refer to Install Root Certificate on page 67.

1. At your workstation, open the web browser and enter the IP Address of the machine in the Address Bar.
2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login.
5. Click Properties.
6. In the Security link on the left hand side select the Network Security link.
7. Select 802.1X in the directory tree. The 802.1x Security page displays.
   a. For 802.1x Security, check the Enable checkbox to enable.
   b. From the Authentication Methods area select one of the following methods:
      - EAP-MD5
      - EAP-MSCHAPv2
      - PEAP
      - TLS

8. If you select EAP-MD5, EAP-MSCHAPv2 or PEAP, the Credentials option appears. Enter the required details in the Username and Password fields.
9. If you select PEAP or TLS, the Server Validation option appears. Click the Select Certificate button and select the required root certificate to provide server validation.
10. If you select TLS, the Device Validation option appears. Click the Select Certificate button and select the required certificate to provide device validation.
11. Select the Apply button to accept the changes.
12. Select OK when the acknowledgement message displays.
Display Network Settings

The **Display Network Settings** feature allows you to control the network information that displays on the machine control panel.

1. At your workstation, open the web browser and enter the *IP Address* of the machine in the Address Bar.
2. Press **Enter**.
3. Select the **Properties** icon.
4. If prompted, enter the *Administrator User Name* (**admin**) and *Password* (**1111**), and select **Login**.
5. Click **Properties**.
6. In the **Security** link on the left hand side select the **Network Security** link.
7. Select **Display Network Settings** in the directory tree. The **Display Network Settings** page displays.
8. In the **Options** area, select one of the following options:
   - Hide Network Information
   - Show IPV4 Address
   - Show HostName
9. Select **Apply** to save the changes.
10. Select **OK** when the acknowledgement message displays.
Display Network Settings
CentreWare Internet Services

This chapter explains how to enable and use the CentreWare Internet Services (Internet Services) feature of the machine.

The following topics are covered in this chapter:

- **Overview** on page 80
- **Status** on page 81
- **Jobs** on page 82
- **Print** on page 83
- **Properties** on page 84
- **Support** on page 95
Overview

Internet Services uses the embedded HTTP Server on the machine. This allows you to connect to the machine through a web browser, to configure or change machine settings.

Enter the IP Address of the machine in the URL (Universal Resource Locator) field of a browser to access the Internet Services home page.

Information Checklist

Before starting please ensure that the following items are available and/or the tasks have been performed:

- The machine should be connected to the network with TCP/IP enabled and configured.
- An existing operational workstation with TCP/IP Internet or Intranet accessibility is required.
- HTTP (Hyper Text Transfer Protocol) should be enabled on the machine. HTTP is enabled by default. If you need to enable HTTP, see Enable HTTP at the machine on page 80.

Enable HTTP at the machine

Hyper Text Transfer Protocol (HTTP) must be enabled on the machine in order to access the embedded web pages.

Note HTTP is enabled by default.

1. Press the Menu button.
2. Use the up/down arrows to select Network Setup.
3. Enter the Administrator password. The default is 1111. Refer to Entering a password: on page 14.
4. Use the arrow buttons to select HTTP Activate.
5. Use the arrow buttons to select On.
6. Press OK. The NIC Changed, Please Reboot message will appear.
7. Press the power switch off, wait two seconds and press the power switch back on.

Access Internet Services

1. Open a web browser from your workstation.
2. In the URL field, enter http:// followed by the IP Address of the machine. For example: If the IP Address is 192.168.100.100, enter the following into the URL field: http://192.168.100.100.
3. Press Enter to view the Home page.
4. Select an icon to access the desired page, or select the Index icon at the top of the machine web page to access the index list.
Status

The **Status page** allows you to view any active alerts being displayed by the machine, and see the status of the print cartridge.

The **Usage Counters** page allows you to view the number of impressions made by the machine. This page also displays the machine serial number and in the **Current Settings** menu, information about the machine setup and network information can also be viewed.

The **Print Information** page allows you to print the configuration report and other documents about the machine.

1. At your workstation, open the web browser and enter the **IP Address** of the machine in the Address Bar.
2. Press **Enter**.
3. Select the **Status** icon.
4. Select the option in the menu on the left side of the page to view the required information:
   - **Active Alerts**: shows current issues reported by the machine and the skill level required to fix them.
   - **Supplies**: shows the status of the Xerox Black Print Cartridge.
   - **Usage Counters**: shows the Machine Serial Number and the number of impressions completed by the machine.
   - **Current Settings**: which contains **Machine Information** and **Network Information**. **Machine Information** displays information about the System and **Printer**. **Network Information** displays information about the Protocols configured on the machine.
   - **Print Information**: allows you to print the Configuration Report, Font Lists, System information and other reports related to the machine.

Print Information

1. In the **Status** page, select **Print Information**.
2. Select the required report in the **Print Information** screen by selecting the checkbox next to the report that you want to print.
3. Select the **Print** button.
4. Select **OK** when the acknowledgement message displays.
Jobs

The Jobs tab is not present on the Phaser 3320DN/3320DNI unless RAM disk is enabled. The Job Management page provides information about active, stored and secure print jobs.

Click the links in the left hand menu to see your jobs. The options are:

- Active Jobs
- Stored Print
- Secure Print

To view the Job Management page

1. At your workstation, open the web browser and enter the IP Address of the machine in the Address Bar.
2. Press Enter.
3. Select the Jobs icon.
4. To view the status of current jobs at the machine select the Active Jobs link. To delete an active job, select the required job and press the Delete button.
5. To view the status of Sample Print jobs, select the Stored Print link.
6. To view the status of Secure Print jobs, select the Secure Print link.

For further information refer to the Phaser 3320DN/3320DNI User Guide delivered with your machine.
Print

File Download

Print-ready documents can be quickly and easily submitted for printing using the File Download page.

A print-ready document is a file that has been formatted and saved for printing from the application that created it, or the Print to File check box was checked in the printer driver screen.

The following file formats can be printed from the Job Submission page:

- PCL
- PostScript®
- Plain Text
- PRN files

1. At your workstation, open the web browser and enter the IP Address of the machine in the Address Bar.
2. Press Enter.
3. Select the Print icon. The Print Options page displays.
4. Select the number of copies required in the Quantity menu.
5. Select the required orientation of your print from the Orientation menu.
6. Select the required option for 2-Sided printing.
7. In the Print-Ready File area, select the Browse button. The File Download page displays.
8. Select the print-ready document and select OK.
9. Select Apply to print the document.
Properties

The Properties tab allows you to configure Machine Settings, Network Settings and Security information. You must be logged in as the Administrator to view the Properties pages.

1. At your workstation, open the web browser and enter the IP Address of the machine in the Address Bar.
2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login.
5. Click Properties.

Machine Settings

The Machine Settings menu contains the following features:

- Firmware Version
- System
- Printer
- E-mail Notification

Firmware Version

1. Access the Properties tab.
2. In the Machine Settings link select the Firmware link. The Version Information area displays the following information:
   - System version
   - Main Controller
   - Network
   - IP Core software version
   - Image Output Terminal
   - PCL5X
   - PCLXL
   - PS
   - IBM/EPSON

System

The System page allows the user to change the following preferences:

- Setup - includes General machine information such as language and power save settings.
- Earth Smart - allows you to set features to save energy and paper on the machine.
- Input Tray - allows you to set the input tray information.
- RAM Disk - Enables/disables RAM disk to manage jobs.
**Setup**

1. At your workstation, open the web browser and enter the *IP Address* of the machine in the Address Bar.
2. Press **Enter**.
3. Select the **Properties** icon.
4. If prompted, enter the *Administrator User Name* (admin) and *Password* (1111), and select **Login**.
5. Click **Properties**.
6. In the **Machine Settings** link select the **System** link.
7. Select **Setup**. The **General** page displays.
8. In the **Host Name**, **Location**, **Contact**, **Xerox Asset Tag Number** and **Customer Asset Tag Number** areas enter the required information for the device.
9. Select the required language from the **Language** drop-down menu.
10. Select the required emulation from the **Emulation** drop-down menu.
11. From the **Power Save** drop-down menu select the required time for the machine to enter power save mode.
12. Select the required options for the **Power Save Wakeup Event**.
13. Select the required options for:
   - **Altitude Adjustment**
   - **Toner Low Alert**
   - **Toner Save**
   - **Line Termination**
   - **Job Timeout**
14. Select **Apply** to save the changes.
15. Select **OK** when the acknowledgement message displays.

**Earth Smart**

The Earth Smart feature allows you to configure options to decrease the amount of energy and paper used in the printing process and displays a visual representation of savings made.

**Configure Earth Smart Settings**

1. In the **Machine Settings** link select the **System** link.
2. Select **Earth Smart**.
3. Select **Settings**. The **Default Mode** page displays.
4. Select the required option:
   - Select **On** to enable Earth Smart,
   - Select **On-forced** to enter a 4 - 8 digit password.
5. In the **Features Configuration** area:
   a. Select **Factory Default** if you want to retain the default Earth Smart settings.
   b. To change the Earth Smart settings, select **Custom Settings**.
   - Select **Edit and Preview Simulator**.
• Select the required settings for 2-Sided, N-Up, Skip the Blank Pages, and Toner Save. The simulator shows estimates for the CO², Energy and Paper savings.

c. Click OK to save your changes.

Input Tray

To access the Input Tray settings

1. In the Machine Settings link select the System link.
2. Select the Input Tray link. The Input Tray page displays.
3. In the Paper Size area, from the following drop-down menus select the required paper size settings:
   • Tray 1
   • Tray 2
   Note Tray 2 is only available with the Optional Tray installed.
   • Bypass Tray
4. In the Paper Type area, from the following drop-down menus select the required paper type settings:
   • Tray 1
   • Tray 2
   • Bypass Tray
5. To enable Bypass Mode, select the Enable checkbox in the Tray Mode area if required.
6. Select Apply to save the changes.

Ram Disk

1. In the Machine Settings link, select the System link.
2. Select the RAM Disk link. The RAM Disk page displays.
3. To enable RAM Disk, select the Enable checkbox in the Ram Disk area.
4. Select the required size (16 - 32)MB.
5. Select Apply to save the changes.

Printer

The Printer screens allow you to set the options for:

• Graphic
• Layout
• PCL
• PostScript
• EPSON/IBM
• Font and Macro Download
**Graphic**

To access the Graphic settings:

1. In the **Machine Settings** link select the **Printer** link.
2. Select **Graphic**.
3. In the **Graphic** area, from the following drop-down menus select the required settings:
   - Resolution
   - Darken Text
4. Select **Apply** to save the settings.

**Layout**

To access the Layout settings:

1. In the **Machine Settings** link select the **Printer** link.
2. Select **Layout**.
3. In the **Layout** area, from the following drop-down menus select the required options:
   - Layout
   - Common Margin
   - Advanced Margin - select the Setting buttons to change the options for **Tray 1**, **Tray 2**, **Bypass Tray** and **Emulation Margin**.
4. Select **Apply** to save the settings.

**PCL**

To access the PCL settings:

1. In the **Machine Settings** link select the **Printer** link.
2. Select **PCL**.
3. In the **PCL** area, from the following drop-down menus select the required options for the PCL font:
   - Typeface
   - Symbol Set
   - Lines
   - Pitch
   - Courier
4. Select **Apply** to save the settings.

**PostScript**

To access the PostScript settings:

1. In the **Machine Settings** link select the **Printer** link.
2. Select **PostScript**.
3. In the **PostScript** area, select **Enable** to select **Print PostScript Error**.
4. Select **Apply** to save the settings.

**EPSON/IBM**

To access the EPSON/IBM settings:

1. In the **Machine Settings** link select the **Printer** link.
2. Select **EPSON/IBM**.
3. In the **EPSON/IBM** area, select the required settings:
   - Font
   - Auto Wrap
   - Character Set
   - Character Table
   - LPI
   - Pitch
4. Select **Apply** to save the settings.

**Font and Macro Download**

The Font and Macro Download page allows you to add the following to the machine:

- PCL Font
- PCL Macro
- PS Font

**Note** Ensure the required font or macro file is available on your computer.

1. In the **Machine Settings** link select the **Printer** link.
2. Select **Font and Macro Download**.
3. Select the **PCL Font, PCL Macro** or **PS Font** tabs as required.
4. Select **Add**.
5. In the **File** area:
   a. Select the **Browse** button.
   b. Select the required font or macro file on your computer.
   c. Select **Open**.
6. If you selected PCL Font or PCL Macro, enter the required **ID**.
7. Select the **Apply** button.
8. Select the **Print List** button to view the font or macro list.

**E-mail Notification**

The **E-mail Notification** page allows you to set up e-mail alerts to notify users or operators of problems as they occur on the machine.

1. At your workstation, open the web browser and enter the **IP Address** of the machine in the Address Bar.
2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login.
5. Click Properties.
6. In the Machine Settings link select the E-mail Notification link.
7. Select the Enable checkbox to enable E-mail Notification.
8. To create a new e-mail notification, in the Recipients & Conditions area, select Add. The Add screen appears.
9. Enter the name of your recipient in the Name box.
10. Enter the E-mail address(es) for the people that you want to be notified of the machine problems. Multiple e-mail addresses can be entered; the e-mail addresses must be separated by semi-colons.
11. In the Notification area, click the box next to Notification to be notified of all events, or select the specific events that you want to be notified of:
   - Consumable Shortage Warning
   - System Errors
   - Device Status
   - Firmware Upgrade Notification
   - Warn me when Admin Password is expired
   - Warn me when Admin Password has been changed
   - Security Settings Reset
12. Some notifications require additional settings:
   a. If you select Consumable Shortage Warning, select Setting... and enter the required setting for the Toner Level. Select Apply.
   b. If you select Device Status, select Setting... and enter the required information for Notification Schedule and Reports to be attached in E-mail. Select Apply.
13. Select Apply to save the changes.

Network Settings

The Network Settings screens allow you to set the properties for the following options:
- General, which includes Ethernet Speed
- TCP/IPv4
- TCP/IPv6
- Raw TCP/IP, LPR, IPP
- Telnet
- WSD
- SLP
- UPnP
- mDNS
- SNMP
- Outgoing Mail Server (SMTP)
- Wireless
• **Restore Default**

1. At your workstation, open the web browser and enter the *IP Address* of the machine in the Address Bar.
2. Press **Enter**.
3. Select the **Properties** icon.
4. If prompted, enter the *Administrator User Name* (**admin**) and *Password* (**1111**), and select **Login**.
5. Click **Properties**.
6. In the **Network Settings** link select the **General** link.

**General**

The General page allows you to set the Ethernet Speed and view the device MAC address. For instructions on how to set the Ethernet Speed, refer to **Setting the Ethernet Speed Using Internet Services** on page 20.

**TCP/IP**

The TCP/IPv4 and TCP/IPv6 pages allow you to configure the TCP/IP settings on the device. For instructions refer to **Network Installation** on page 23.

**Raw TCP/IP, LPR, IPP**

The Raw TCP/IP, LPR IPP page allows you to configure the Raw TCP/IP (Port 9100), LPR (Line Printer Remote) and IPP (Internet Printing Protocol) settings on the device. For instructions, refer to **Windows Printing** on page 49.

**Telnet**

The Telnet page allows you to configure Telnet settings on the device.

1. In the **Network Settings** link select the **Telnet** link.
2. Select **Enable** to enable the **Telnet Protocol**.
3. Enter the required information to configure the following settings:
   - Port Number
   - Login ID
   - Password
4. Select **Apply** to save the settings.

**WSD**

The WSD page allows you to enable the WSD protocol on the device.

1. In the **Network Settings** link select the **WSD** link.
2. Select **Enable** to enable the **WSD Protocol**.
3. Select **Apply** to save the settings.
Properties

SLP
The SLP page allows you to configure the SLP protocol (Service Location Protocol) on the device.

1. In the Network Settings link select the SLP link.
2. Select Enable to enable the SLP Protocol.
3. Enter the required information to configure the following settings:
   - Scope 1, 2 and 3
   - Message Type
   - Multicast Radius
   - Registration Lifetime
4. Select Apply to save the settings.

UPnP
The UPnP page allows you to configure the SSDP protocol (Simple Service Discovery Protocol) on the device.

1. In the Network Settings link select the UPnP link.
2. Select Enable to enable the SSDP Protocol.
3. Enter the required information for SSDP TTL.
4. Select Apply to save the settings.

mDNS
The mDNS page allows you to enable the MDNS protocol (Multicast DNS) on the device. This protocol is used in Bonjour (formerly Rendezvous) from Apple.

1. In the Network Settings link select the mDNS link.
2. Select Enable to enable the mDNS Protocol.
3. Select Apply to save the settings.

SNMP
The SNMP page allows you to configure the SNMP (Simple Network Management Protocol) v1, v2 and v3 settings on the device. For instructions, refer to SNMP on page 69.

Outgoing Mail Server (SMTP)
The Outgoing Mail Server (SMTP) page allows you to configure the SMTP (Simple Mail Transfer Protocol) settings on the device.

1. In the Network Settings link select the Outgoing Mail Server (SMTP) link.
2. In the Simple Mail Transfer Protocol (SMTP) area:
   a. Enter the IP or host name of the SMTP Server.
b. Enter the Port Number. The Port field can have a value from 1 to 65535. The default Port Number is 25.
c. Check the SMTP Requires Authentication checkbox if your mail server requires the machine to log in.
d. Enter details in the Login ID and Password fields required for the machine to authenticate at the mail server.
e. Enter a password in the Confirm Password field.
f. Select POP3 Authentication to enable this option and enter the required settings.
g. In the Advanced area, select Secure E-mail Connection with SSL/TLS if this option is required.
h. Enter a value for server connection timeout in the SMTP Server Connection Timeout field. The range is 30 - 120 seconds, and the default is 30 seconds.
i. Enter the required details for the Default From Address.
j. Select the SMTP Configuration Test button to test your settings.

3. Select Apply to save the changes.

Select OK when the acknowledgement message displays.

Wireless (Phaser 3320DNI)

The Wireless page allows you to view the wireless connection status and configure the wireless settings. For instructions refer to Configure Wireless Connectivity Using Internet Services (Phaser 3320DNI) on page 19.

Restore Default

The Restore Default page allows you to clear the machine’s network settings.

1. In the Network Settings link select the Restore Default link.
2. Select the Clear button.
3. The Do you really want to restore network settings message appears. Click Yes.
4. Reboot the machine for changes to take effect.

Security

The Security screens allow you to view and set the properties for the following options:

- Security Summary
- System Security
- Network Security

Security Summary

The Security Summary page allows you to view the settings for:

- System Security
• **Network Security**

1. At your workstation, open the web browser and enter the *IP Address* of the machine in the Address Bar.
2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login.
5. Click Properties.
6. In the Security link on the left hand side, select the Security Summary link.
   The System Security screen displays information about Access Control and Advanced Access Control.
7. In the Security Summary page, select the Network Security tab. The Network Security tab displays the settings configured on the device for:
   • Secure Connection (HTTPs)
   • Simple Network Management Protocol v3
   • IP Security
   • IP and MAC Address Filter
   • 802.1x Security

**System Security**

The System Security pages allow you to configure security settings on the device for:
• System Administrator
• Feature Management
• Restart Device

**System Administrator**

The System Administrator page allows you to change the administrator password and control access to Internet Services (the Web UI) and the device control panel (the LUI or Local User Interface). For instructions, refer to Administrator Accounts on page 62.

**Feature Management**

The Feature Management page allows you to control access to the machine services, physical ports and network protocols used on the device. For instructions, refer to Feature Management on page 62.

**Restart Device**

The Restart Device screen allows you to reboot the machine remotely from your desktop. For instructions, refer to Restart Device on page 63.

**Network Security**

The Network Security pages allow you to configure security settings on the device for:
• Digital Certificate
Properties

- Secure Connection
- SNMPv3
- IP Security
- IPv4 Filtering
- IPv6 Filtering
- MAC Filtering
- 802.1x
- Display Network Settings

For instructions on how to configure the Network Security settings, refer to Security Settings on page 62.

Display Network Settings

The Display Network Settings screen allows you to control the network information that displays on the machine control panel. For further information, refer to Display Network Settings on page 77.
Support

The Support tab provides details of the machine **Version Information** and allows you to perform a **Firmware Upgrade**. You can also configure **Contact Information** for the System Administrator and Xerox support information. The Support tab provides **Support Links** to pages on [www.xerox.com](http://www.xerox.com) that provide helpful information, for example drivers and documentation.

**Note** You must be logged in as the **Administrator** to perform a Firmware Upgrade.

Version Information

The Version Information area displays the machine’s firmware versions.

1. At your workstation, open the web browser and enter the **IP Address** of the machine in the Address Bar.
2. Press **Enter**.
3. Select the **Support** icon. The **Version Information** page displays.

Firmware Upgrade

For information on how to upgrade the machine firmware, refer to **Software Upgrade using Internet Services** on page 99.

To Edit Contact Information Details

1. At your workstation, open the web browser and enter the **IP Address** of the machine in the Address Bar.
2. Press **Enter**.
3. Select the **Support** icon. The **Support** page displays.
4. When prompted, enter the **Administrator User Name** (**admin**) and **Password** (**1111**), and select **Login**.
5. In the **Contact Information: System Administrator** area, select the links to enter or edit details in the following fields:
   - Name
   - Phone Number
   - Location
   - E-mail Address
6. In the Xerox Support area, enter information for the following fields:
   - **Customer Support Phone Number**
   - **Services Phone Number**
   - **Supply Phone Number**
7. Select **Apply** to save the changes.
8. Select **OK** when the acknowledgement message displays.
Support Links

To view Support Links or to register your device on www.xerox.com:

1. At your workstation, open the web browser and enter the IP Address of the machine in the Address Bar.
2. Press Enter.
3. Select the Support icon.
4. Select Support Links within the Support tab.
5. Select the required link to access information.
This chapter explains how to upgrade the machine software when requested by a Xerox Customer Support Centre Representative and includes the following topics.

- Overview on page 98
- Software Upgrade using Internet Services on page 99
Overview

The Software Upgrade feature allows the customer to upgrade the machine software as requested by a Xerox Customer Support Centre Representative, without needing a Customer Service Representative to be present.

When should I upgrade the software?

Xerox is continually seeking to improve its products and a software revision may become available to improve the functionality of the machine. Your Customer Support Centre Representative will instruct you to upgrade your machine when it is necessary.
Software Upgrade using Internet Services

Note Any jobs in the queue must be allowed to complete or be deleted before initiating a software upgrade. This procedure will prevent further jobs from being received until the upgrade has completed. All configured network settings and installed options will be retained by the machine after the Software Upgrade process.

Information Checklist

Before starting please ensure that the following items are available and/or the tasks have been performed:

- Obtain the new software upgrade file for your machine from the www.xerox.com web site or from your Xerox Customer Support Representative. The upgrade file will have an extension of .hd. Download the upgrade file to a local or network drive. You will be able to delete the file after the upgrade procedure.
  It is important to obtain the correct upgrade file for your particular model of machine.
  For instructions to determine which model of machine you have, refer to Firmware Version on page 84.
- TCP/IP and HTTP protocols must be enabled on the machine so that the machine web browser can be accessed.

Procedure

1. At your workstation, open the web browser and enter the IP Address of the machine in the Address Bar.
2. Press Enter.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login.
5. Click Properties.
6. In the Security link on the left hand side select the System Security link.
7. Select the Feature Management link in the directory tree.
8. Select the Firmware Upgrade Enable box.
9. Click Apply to save the changes.
10. Select Support.
11. Select the Firmware Upgrade link.
12. Select the Upgrade Wizard button. The Firmware Upgrade Wizard screen appears.
13. In the Firmware File area:
   a. Select Browse.
   b. Locate and select the software upgrade .hd file obtained earlier.
   c. Select Open.
14. Select Apply to send the file to the machine.
15. The file will be sent to the printer and will disable the printing functionality. The web browser will become inactive and you will not be able to access the machine via this method until the upgrade has completed and the machine has rebooted. The upgrade should take no longer than 30 minutes.

16. Once the machine has completed the upgrade it will reboot automatically. The configuration report will print (if enabled). Check the configuration report to verify that the software level has changed.
Troubleshooting

This chapter contains procedures and actions to resolve problems you may encounter with your printer.

- Problem Solving Procedure on page 102
- Printing on page 103
- Connectivity on page 104
Problem Solving Procedure

This section enables you to identify the network-related machine problems. Use the following steps to identify and solve the problem. If the problem is not network related, refer to the User Guide for corrective action.

1. Resolve any local printer problems first. Perform the corrective action that is recommended by the User Guide. Do not attempt to resolve a network problem if the local printer functions are not operating correctly.
2. Check that the machine has power and it is switched on.
3. Check that the network cable is connected to the machine.
4. Check that the network cable is connected to the workstation.
5. Check that the correct printer driver for the machine is selected at the workstation.
6. Check that the software application being used to send print jobs is set up correctly.
7. If printing is not available from a workstation, re-install a printer driver on the workstation.
8. Call the local Xerox Welcome Center, where a representative will assist in the diagnosis and solution of the problem.
## Printing

| I cannot print to the machine. | 1. Ensure that there are no network connectivity problems with the Xerox machine.  
2. Print a Test Page from the Xerox printer driver to the machine to verify connectivity.  
3. Ensure that the print server is functional.  
4. Print a Configuration Report at the Xerox machine to ensure that the network address information is correctly configured. See [Print a Configuration Report](#) on page 16.  
5. Ensure that the correct printer driver is installed on the User’s workstation. |
|--------------------------------|---------------------------------------------------------------------------------------------------------------|
| The machine is printing slowly.| 1. Configure the Xerox machine with an Ethernet speed that matches the speed set on your hub or switch.  
2. Ensure that the correct printer driver is installed on the User’'s workstation. |
## Connectivity

<table>
<thead>
<tr>
<th>Problem</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The machine is not available on the network.</td>
<td><strong>Network Connectivity</strong>&lt;br&gt;1. Print a Configuration Report at the machine to ensure that the network address information is correctly configured. See <a href="#">Print a Configuration Report</a> on page 16.&lt;br&gt;2. Connect to the machine’s IP address from a web browser to check connectivity.&lt;br&gt;3. Ensure that the machine is configured with an Ethernet speed that matches your hub or switch.&lt;br&gt;4. Ensure that the machine’s Ethernet cable is correctly patched in at the hub/switch.&lt;br&gt;5. Ensure that the machine’s Ethernet cable is functioning.&lt;br&gt;6. Ensure that other computers on your network can communicate.</td>
</tr>
<tr>
<td>The machine has an incorrect IP Address.</td>
<td><strong>Test TCP/IP Connectivity</strong>&lt;br&gt;1. Ping the address of the machine from a command prompt window.&lt;br&gt;2. If you receive a reply, the machine may be configured with a duplicate IP Address. Unplug the Ethernet cable from the machine and ping the IP Address again. If you still receive a reply, re-connect the Ethernet cable.&lt;br&gt;3. If you do not receive a reply when you ping the machine’s IP Address, check the network cables at the machine and the computer that you are using to ping the machine.&lt;br&gt;4. Configure the Xerox machine with an Ethernet speed that matches the speed set on your hub or switch.&lt;br&gt;5. Ensure that the Ethernet cable is correctly patched in at the hub/switch.&lt;br&gt;6. Try a different Ethernet cable at the machine.&lt;br&gt;7. Check that other machines/computers can communicate over the network.</td>
</tr>
<tr>
<td>Incorrect IP Address</td>
<td></td>
</tr>
<tr>
<td>----------------------</td>
<td></td>
</tr>
</tbody>
</table>
| In certain situations you may find the machine is configured with an incorrect IP Address or displays a network error. There are several possible causes of this:  

1. When the machine boots up it discovers that it has been configured with an IP Address that is owned by another machine.  

   **Solution** - Configure the machine with a unique IP Address.  

2. The machine cannot connect to the DHCP or BootP server. The machine will use AutoIP to establish an address.  

   **Solution** - Check the DHCP or BootP server works correctly. Configure the printer with a static IP Address.  

3. The printer has an IP Address of 169.254.x.x.  

   **Solution** - The machine cannot connect to the DHCP or BootP server. The printer has used AutoIP to establish an address. Check the DHCP or BootP server works correctly. Configure the printer with a static IP Address.  

   **Note**  

   **AutoIP (AutoNetting)** When DHCP or BootP are enabled on the machine, AutoIP is automatically enabled. If a DHCP or BootP server does not respond with an IP Address, the machine will use AutoIP to configure its own IP Address in the 169.254.0.0 range. When the machine connects to the DHCP or BootP server it will obtain a dynamic IP Address as normal. If the machine is configured with a static IP Address, it will not use AutoIP.  

<table>
<thead>
<tr>
<th>I cannot access Internet Services.</th>
</tr>
</thead>
</table>
| 1. Ensure that the Xerox machine is configured with a valid IP Address.  

2. Ensure **HTTP Activate** is enabled within the **Menu > Network Setup** area at the machine control panel.  

3. Within your web browser, set the option to bypass the proxy server for local addresses.  

Connectivity
Appendix A

Management Information Base (MIB)

A MIB (Management Information Base) is a database of objects that can be accessed by a network management system.

Xerox public MIBs are located at: http://origin-download.support.xerox.com/pub/drivers/MIBs/

Customers can download the MIBs and use their SNMP tool to obtain the required information.

*Note* All information presented on the control panel display is also presented in the MIB and CentreWare Internet Services. This includes e-mail addresses, phone numbers and passwords as they are being entered. If this presents a security concern, Xerox recommends enabling the SNMPv3 and the IP Filtering security feature in order to control remote access to the device.

For SNMPv3, refer to [SNMPv3](#) on page 71 and for IP Filtering, refer to [IP Filtering](#) on page 73.
Index

Numerics
802.1X
    Enable, 75
    Overview, 75

A
Access CWIS, 80
Access Internet Services, 80
Add the Printer, 50
Administrator Access, 14
Administrator Accounts, 62
Administrator Password Change, 19
Appendix A, 107
Apple Mac, 58
    TCP/IP
        Install Printer Driver, 58
        TCP/IP (OSX), 58
Arrow buttons, 10

B
Back button, 10
BOOTP, 25
Bypass Tray, 12
    Extension, 12
    Width Guides, 12

C
CentreWare Internet Services, 18, 79
    Access CWIS, 80
    Enable HTTP, 80
    Overview, 80
    Print, 83
Configuration Report, 16
Configure
    Apple Mac Printer Driver, 59
    Solaris 2.x
        Client
            GUI Method, 31
            tty Method, 31
    Static Addressing, 24
    Unix
        Solaris Client, 31
Configure Static IP Addressing, 24
Connection Ports, 12
Control Board Cover, 12
Control Panel, 10, 12
Create
    Certificate Signing Request, 65
    Self Signed Certificate, 65
Create a New Print Queue from your Workstation, 49
CUPS, 33
    CWIS, 18, 79

D
DHCP, 25
Digital Certificate
    Create, 65
    Create Request, 65
Digital Certificate Management
    Access, 64
    Create Self Signed Certificate, 65, 66
    Overview, 64
Duplex Unit, 13
Dynamic Addressing
    Linux CUPS, 34

E
Entering a password, 14

F
File Download, 83
Front Cover, 12

G
GUI Method, 31

H
HP-UX Client (Version 10.x), 29
HTTP
    Enable SSL, 67

I
IEEE 1284 Parallel Connector (Optional), 13
Initial Connection, 13
Install
  Printer Driver for RAW TCP/IP / Port 9100 (Windows), 54
  Printer Driver for TCP/IP (Apple Mac), 58
Install Printer Driver, 50
Installation Wizard, 14
Installing the Printer Setting Utility, 43
Installing the SmartPanel, 43, 45
Interface Ports, 13
Internet Printing Protocol (IPP) Port, 52
Introduction, 7
IP Filtering
  Overview, 73
IP Sec
  Enable, 72
IPv4, 26
IPv4 Filtering, 73
IPv6, 26
IPv6 Filtering, 73

L
Linux
  CUPS, 33
    Installing Drivers, 43, 45
Linux CUPS
    Dynamic Addressing, 34
    Static Addressing, 33
Linux LPR via PrintTool, 34
Linux LPRng, 35

M
Machine Components, 9
Machine components, 9
Machine Connection, 11
Machine Digital Certificate
  Create Signing Request, 65
Machine Digital Certificate Management
  Access, 64
  Create Self Signed Certificate, 65, 66
  Overview, 64
Machine Overview, 9
Machine Parts, 12
Machine Timer Values, 107
Macintosh, 48
  Installing Driver, 41
Manual Printer Driver Configuration, 56
Menu button, 10

N
Network Installation, 23
Network Port, 13

O
OK button, 10
Output Tray, 12
Output Tray Support, 12
Overview
  Printer Drivers, 38

P
Paper Level Indicator, 12
Paper Tray 1, 12
Paper Tray 2 (Optional), 12
Paper Tray Rear Cover, 13
Power Receptacle, 13
Power Save button, 10
Print, 83
Print a Configuration Report, 16
Print Queue
  Linux CUPS
    Dynamic Addressing, 34
Printer Driver
  Install for TCP/IP (Apple Mac), 58
Printer Drivers, 37
  Apple Mac, 58
    TCP/IP (OSX), 58
  Configure
    Apple Mac Printer Driver, 59
    Enable Unix, 49
  Windows
    Raw TCP/IP Printing (Port 9100), 54
  LPR Printing, 49
Printer drivers
  USB Printing (Windows XP/2000/2003), 55
Product Configurations, 9

R
Rear Door, 13